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1. Introduction 
Movicon User Guide Contents 

 

The User Guide contains all the necessary information for the operator for using 
Movicon 9.1. 
The chapters in this User Guide describe the projects, the resources, the objects, 
and the logical and graphic programming techniques used to allow for optimal use 
of system resources in the development of a project. 
Descriptions are also given for using a program, using the data and recipe settings, 
using objects and everything that concerns a system resource. 
This manual also contains the description of the standard techniques for using 
dialog boxes in Windows environment, techniques already described in detail in the 
Microsoft Windows User Manual to which reference must be made if one is familiar 
with the operating system. 

 
 
The application project that the operator uses cannot be described in this 
manual, the contents of which are of a generic nature. Therefore  the 
operator who requires more information must consult the operating 
specifications or other similar descriptions prepared by the manufacturer 
of the plant or application developer. 
 

 
 

Any updates, corrections and additions to the existing manual can be 
found in the “Readme.txt” file located on the installation disks and 
automatically installed in the Movicon “Doc” installation directory. 
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1.1. Preface 
All the information provided in the Movicon documentation is based on the 
assumption that: 

• All the illustrations in this manual refer to the 9.1 version with Windows 
2000 platform. Unless otherwise specified, Movicon’s features refer to 
version 2000. 

• Windows98, Window ME, Windows NT, Windows 2000 and Windows XP 
refer to the trademarks of Microsoft Inc.  

• Crystal Report refers to the product registered by Seagate, version 8.0. or 
previous. 

• Movicon refers to the supervision system developed by Progea Srl and 
protected by international Copyright laws, version 9.1 or later. 

• For any other trademark or product quoted please refer to its owner. 
• Windows is installed in the system. For information on installation refer to 

the relevant chapters in the Microsoft Windows “Introduction Guide”. 
• A mouse has been installed. If a mouse is not available, check the 

keyboard equivalents. 
• All the information contained in this manual is subject to change without 

advance notification due to system updating. 
 

1.2. Keyboard and Mouse Conventions  
The keyboard conventions and combinations appear in this format: 
 

KEY1 + KEY2 A (+) sign between the names of the keys indicates that they 
must be pressed simultaneously. 

 
KEY1 , KEY2 A (,) sign between the names of the keys indicates that they 

must be pressed in sequence. For example ALT,F means you 
must press and release ALT, then press and release F. 

 
 
Important: The keys and key combinations in this manual are to be considered 
valid provided they are not being used in the project by the Movicon Accelerators, 
i.e. the plant’s keyboard commands. If used in the project, plant command keys 
have precedence over system keys. 
For further information refer to the "Accelerators" chapter in this programming 
manual. 
 
When using the Mouse, the following conventions are used: 
 

CLICK Press and release the left mouse button while pointing to a 
menu or an object. 
 

DOUBLE-CLICK Quickly press the left mouse button twice. 
 

DRAG Press the left mouse button while pointing to the required 
object; hold the button down while moving the mouse pointer 
to the required position, then release the button. 
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1.3. Introduction to the Supervision 
System  

Movicon (Monitoring, Vision, and control) is a software package designed for the 
creation of  a man-machine interface (MMI), a Supervisory, Control and Data 
Acquisition station (SCADA) based on a Personal Computer (henceforth referred to 
as PC) or on a RISC platform (henceforth referred to as Workstation). 
The Movicon drivers allow for communication with the process Movicon has to 
interact with. The process management devices, such as PLC, temperature 
controllers, smart cards, PC, etc., can all be connected to the system in which 
Movicon is installed (including multitasking) via serial ports, modems, 
communication networks, etc. 
The purpose of a Movicon project is to supervise the production processes using 
animated screen pages called synoptic windows, or allow process commands or set-
points to be set using screen pages called dialog boxes, as well as a wide range of 
other functions which permit complete control of the process in a simple, reliable 
manner.  
Movicon 2000 is available for the following operating systems: 
 
; MICROSOFT WINDOWS 98 
; MICROSOFT WINDOWS Me 
; MICROSOFT WINDOWS NT 4.0 or later 
; MICROSOFT WINDOWS 2000 
; MICROSOFT WINDOWS XP 
 
 

 
 

Example of configuration of Scada systems connected 
in a network or serially to various management devices. 
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1.4. Hardware Requirement 
Movicon (Monitoring, Vision, Control) is a software package that must be installed 
on a Personal Computer IBM AT 100% compliant with all the peripherals Windows 
compliant. The table below lists the minimal requirements: 
 

Hardware Minimal Advised 
   
CPU Pentium 350 PentiumIII 500 
RAM 64 Mb 128 Mb 
Hard Disk 15 Mb 60 Mb 
Video VGA SVGA 
Mouse Yes Yes 
CD-ROM -- Yes 

 
 
 

1.5. Technical Support 
The customer must fill in the Movicon Customer registration form and send it back 
to receive customer technical support, updates of the development system or parts 
of it considered important (download from the website reserved for registered 
users) and the guarantee covering the software package, from the date of delivery 
as laid down in the contract or purchase license. 
For all information on technical support contact Progea or the dealer where this 
product was purchased. For further information on the product or technical support, 
call Progea (the company that developed the product) on the numbers given on the 
registration form, in the telephone service contract or on the website; be sure to 
quote the serial number of the product you have purchased. 
 

Phone Support  
Registering the product, you will have the right to receive free phone support by 
a technician of Progea. You will find all the needed information about the 
telephone numbers and the free schedules on the Support Card present in the 
package. You can subscribe to the Support Contract, for extended schedules 
for the support and to access to the FTP site allowing to download freely 
updates, new drivers, symbols, examples and other utilities. 
 

World Wide Web 
Visit our site for the support and services that Progea can offer, at the address 
www.progea.com. You can browse through the BugBase OnLine, 
Knowledgebase, FAQ, download the last Build available, see the list of our 
worldwide offices and our local Solution Providers. You can fill in a Form in order 
to send us your suggestions. 
 

E-mail 
To obtain rapid easy technical information by e-mail, 24 hours a day, 7 days a 
week, send your technical questions to the address support@progea.com or 
your commercial requests to sales@progea.com. 

 
Note: For more efficient Technical Support, first read the “Problem Report 
Template” in the ‘Problem.txt’ file on the installation disk. The 
instructions in the “Problem Report Template” allow you to give the 
technical support personnel useful information for identifying the 
problem. 
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2. System installation 
and configuration 
Movicon has a simple guided installation, 
according to Windows standard. System 
startup and application projects may 
require a user license. 

This chapter explains the startup, installation and configuration procedure for 
Movicon for correct use by the system. 
The Microsoft Windows installation already envisages an operating system 
configuration to adapt to the station hardware. Nevertheless, it would be useful to 
follow the instructions given below for further optimization. 
 
 

2.1. Installing Movicon 
The Movicon installation procedure on the hardware station is very simple. To 
proceed with the installation from the CD-ROM, follow the instructions given below:  
 

1) Switch on the computer and run Windows. 
2) Insert the CD-ROM in the drive  
3) Wait for the CD Autoplay or select the Run command from the Window’s 

Start Menu Bar and digit D:\Setup.exe in the edit box. 
 
This will run the Movicon setup program. Select the language, then the “install 
Movicon 9.1” or “Install Movicon CE” item from the setup mask. This will start the 
Movicon installation procedure. 
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2.1.1. Installation of Movicon 9.1 
By starting the installation procedure, the setup will verify any previous 
installations. In case a previous installation is detected, the type of operation to be 
performed will be requested. Otherwise, the actual installation will be started with a 
request for custom installation.  
 

 
 
In case of previous installation, select  
 

 

Modify: It allows to add or remove previously installed program 
parts or components  

 

Repair: It re-installs the software by performing the eventual 
upgrading. 
 

 

Remove: It removes program. 

 
At the end of installation, a group of icons will be created named Movicon, which 
can be accessed by means of the Start button of the Windows application bar. The 
Movicon Group will contain, in the form of an icon, the file Movicon.exe, utilities 
connected to it and text files with further information and upgrades.  
During the installation, which will take a few minutes, type in the directory name 
where the necessary Movicon files are to be organized. If you do not desire to 
change the name or path, just confirm Movicon default directory, which will be 
created with the path: “Programmi\Progea\Mov91”. 
 
 

 
 

Example of start menu 
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2.1.2 Installation of Movicon CE 
The Movicon CE installation procedure consists of two phases: 
 

1. Installation of “Movicon CE Installation Utility” on PC, which will 
conventionally be referred to as Desktop. 

2. Installation of the MovCE RunTime module on device (Pocket PC, Handle 
PC), which will conventionally be referred to as target. 

 
The installation described in point 1) is the same as that described in the previous 
paragraph (2.1.1 Installation of Movicon 9.1) except for the fact that the default 
directories where the Movicon files are copied will be referred to as 
“Programs/Progea MovCE”. The “Programs/Progea/MovCE” directory will contain the 
files necessary for installation of the RunTime MovCE module on the “target” device 
on which Windows CE runs. Each of these files is specific for a certain processor.  
Therefore, depending on the processor resident on the “target” device, the file 
concerned must be installed during point 2). 
For example: if the target is a HPC2000, the processor an “X86”and the operating 
system is Windows CE installed in English, the installation file to be selected will be 
“MovCEEng.HPC2K_X86.CAB”. 
 
Note: MovCE and WinCE must have the same installation language. 
 
The MovCE RunTime module installation on the target, i.e. execution of point 2) 
may be in two ways as described below, depending on whether the Active Sync” 
program is present on the “target”. 
 
Installation by means of Active Sync on the RunTime MovCE module 
For this type of installation, a link must have been established between the “target" 
and “desktop” (See Chapter 2.3 Communication by means of Active Sync). When 
installation from the “Movicon CE Installation Utility” is complete an Active Sync 
communication link is automatically created in the Windows startup menu. 

 

 
 

On making the “MovCE English Installation" link (or “MovCE Installatione Italiana” if 
the language required is Italian) Active Sync will automatically recognize the 
processor on board the “target” and then the RunTime MoviconCE module will be 
installed on the “target”. 

 
The entire operation is automatic, but the operator is given the possibility of 
deciding where the package is to be installed. In HPC2000 devices it is advisable 
to avoid using the default folder as, it is not buffered and therefore its contents 
may be lost when the device is switched off. 
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Manual installation of the RunTime MovCE module 
If the manufacturer has not implemented Active Sync on the “target” device, follow 
the procedure described below to install the MovCE RunTime module on “target”: 
 

1. Establish a connection between “target" and “desktop”. The connection 
may be  a network or serial connection (See Chapter 2.3 Communication 
by means of Active Sync). 

2. Determine the type of processor on board the “target”. 
3. Select on the “desktop” from the Movicon CE installation directory 

“Programs/Progea/MovCE” the file with the .CAB extension specific for that 
processor and copy it on “target”. 

4. From the “target" open a Dos session and enter the command: 
 

\>WCELOAD NomeFile.CAB 
 
Installation of the MovCE RunTime module will thus begin. When it ends, the 
.CAB file will be automatically deleted. 

 
 

 HPC2000devices have not backupped all the RAM memory, but only 
some folders. Informations that are written into volatily memory will be 
loose after a reboot. Due to this it’s strongly recommended to execute the 
command "RegSave" after Movicon CE installation, otherwise the runtime 
module could be executed not correctly. 
 

 

2.2. Disinstalling Movicon 
In compliance with Microsoft standards, Movicon allows a simple dis-installation of 
the system to remove all its files from the PC. 
To remove Movicon, simply activate the icon for the installation/removal of the 
programs in Windows Control Panel. 
Select Movicon from among the programs listed and registered, then double click to 
activate the install/remove program. 
Movicon will startup the setup procedure described in the previous paragraph. From 
the selection menu, select Remove. 
On confirming the procedure, the remove procedures will remove all Movicon files. 
 
 

 
 

 

 

 

 

 

 

 
 

Add/Remove of  applications from Windows Control 
Panel  

 



S Y S T E M  I N S T A L L A T I O N  

 

Movicon© User Manual 19

2.2.1. Uninstalling Movicon CE 
Like Windows 98/2000/NT, WinCE must also on the Control Panel the 
Install/Remove icon for applications by means of which it is possible to remove 
MovCE. However, as the WinCE installation is customized by the manufacturer, 
sometimes it is not possible to remove applications from the Control Panel. In this 
case, a device must contain (in the Windows directory) a file for removal 
operations, “unload.exe”. To remove MovCE using this command, o a DOS window 
and key in the following command: 
 
 \>unload Progea Automation MovCE 
 
MovCE will thus be uninstalled. 
 
 
 

2.3. Communicating with MsActive 
Sync 

Installation of the Movicon package for Windows CE requires the desktop and target 
to be in communication with one another. The connection is brought about by 
Microsoft software Active Sync (at least version 3.5) and may be of three types: 
 

1. Serial or infrared communication on COM port. 
2. Communication on USB port. 
3. Network (Ethernet) and Remote Access Service (RAS). 

 
As soon as communication is established between desktop and target, Active Sync 
requests if a partnership is to be defined. 
 

 
 

 
The partnership is necessary if the data are to be shared and kept synchronized 
between the desktop and target. Usually the use of partnership is frequent in 
PocketPC devices but is rarely used in HPC2000, where it is not successful because 
of lack of suitable modules in the target.  
The HPC2000 devices are generally designed for industrial purposes. They are 
available in different types and sizes: some have different communication ports 
between serials 232 and 485, Ethernet, infrared and USB ports. 
On the other hand, PocketPC, the common palmtop devices, are meant for the 
public as they are user friendly, and allow rapid sharing of data with the desktop 
like: phone directories, internet addresses, files and others. 
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2.3.1. Installing MsActive Sync 
Active Sync is a free Microsoft software package for handling communication 
between Desktop and Target devices with a Windows CE. If Active Sync is not 
installed on the PC Desktop it can be done from the Movicon CD by launching the 
file in the folder “MSActiveSync”. Installation is easy and guided. 
 

2.3.2. Serial communication by means of MsActive Sync 
Serial communication is functional in all Windows CE devices and all that is required 
is a free serial on the PC, a standard serial cable and Active Sync installed on 
Desktop. The communication speed can be brought up to a baud rate of 115200. To 
establish serial communication, proceed as follows: 
 

1. Install Active Sync on Desktop. Then select the COM port to be used. 
Active Sync will remain active awaiting the signal on the serial. 
ATTENTION: although no communication is activated Active Sync 
will keep the serial engaged. To free the serial disable the serial 
connection option, which can be accessed from the “File-Connections 
setting..” menu. 

2. On the Target device, open the control panel and access the 
“Communication” settings. 

3. In the “PC Connection” properties, enable the selection “Allow connection 
with Desktop computer when device is connected”. 

4. In the “PC Connection” properties check to censure that the connection 
used is correct. New connections can be created by accessing the “Remote 
Networking” folder from Programs/Communication. 

5. Close the Communication settings window by pressing Ok. Close the 
control panel. 

6. Connect the Desktop and Target devices using a standard serial cable. 
7. Launch “repllog” selecting Run from the Windows CE Start menu accessible 

from the task bar. 
8. Communication is activated automatically. 
9. On the Desktop Active Sync a window appears requesting if a “Partnership” 

is to be activated. It is not necessary to activate a partnership for Movicon 
functions. 

10. The serial communication is now active. 
 
By means of this type of connection, it is possible to transfer files between Desktop 
and Target. Explore resources from Desktop will display the “Mobil Device” which 
can be accessed for reading/writing files.  Apart from this, it is also possible to 
export a Movicon project directly on Target without “copy and paste” operations. 
After creating the Movicon 9.1 project execute a “Export project for WinCE” from 
the file menu to be able to compile the project in MovCE format. If connection 
between Desktop and Target has already been activated by Active Sync, Movicon 
will directly export the project compiled on Target, maintaining the same path of 
the original .prj file. If, however there is no communication with Target Movicon will 
compile the project for MovCE and save it in the same directory as the Original 
project. The project compiled for MovCE will have the same name added to “_CE” 
(for example. Original project: “Progetto1.prj; project compiled: 
“Progetto1_CE.prj). In this case, it will be the programmer’s responsibility to 
manually copy the file on target.  
 

2.3.3. Communication on USB port 
Communication on the USB port is usually always available in PocketPC because it is 
the simplest type of communication possible. Just connect the cable to the PC USB 
port and wait for communication to be established automatically. 
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2.3.4. Network communication 
Network communication assumes that both PCs, Desktop and Target have network 
cards and are configured suitably. The use of this system allows rapid transfer of 
files as compared with serial communication, which has a maximum baud rate of 
115200. Network communication can only be established after creating a 
partnership therefore it is presumed that communication has already been 
established via serial or USB port.  
 

2.3.5. Exporting a project on Windows CE  
Connection between Desktop and Target by means of Active Sync allows file 
transfer between the two devices or export of projects created with Movicon. 
Explore resources from Desktop displays the “Mobil Device” which can be accessed 
for reading/writing files.  Apart from this, it is also possible to  export a Movicon 
project directly on Target without “copy and paste” operations. After creating the 
Movicon 9.1 project execute a “Export project for WinCE” from the file menu to 
be able to compile the project in MovCE format. If connection between Desktop and 
Target has already been activated by Active Sync, Movicon will directly export the 
project compiled on Target, maintaining the same path of the original .prj file. If, 
however there is no communication with Target Movicon will compile the project for 
MovCE and save it in the same directory as the Original project. The project 
compiled for MovCE will have the same name added to “_CE” (for example. Original 
project: “Progetto1.prj; project compiled: “Progetto1_CE.prj). In this case, it will be 
the programmer’s responsibility to manually copy the file on target. 
 

 
Presently it is not possible to trace the original project from the 
project compiled for MovCE, or make modifications to it; therefore it 
is advisable to keep a copy of the original project. 
 
 

 
 

2.4. Running Movicon 
The simplest way to run Movicon is to run the Movicon.EXE file from Windows. 
To run Movicon.EXE without parameters means to enter in the Movicon Environment 
in programming mode, with the automatic opening of a new project or of the 
previously opened project. Using the correct syntax to add program parameters as 
described below allows you to ‘use’ powerful options. 
Syntax for the run parameters: 
 

Movicon /[Parameters] <file project> . 
 
The optional parameters on the command line can be preceded by both the “/” 
character or the “-“ character. 
The optional parameters (also more than one at a time) are described below: 
 

/G Enables the personalization 
/R Runs a project directly at the Movicon startup 
/X Runs the Maximize work area command (Ctrl+Shift+F5) 
/N Does not open a project by default 
/S Does not show the Movicon splash window 
/? Shows run parameters at startup 

 
Other options available, reserved only for expert developers are as follows: 
  

/E The “Exit from Movicon” command  also causes exit from Windows  
/Tn Set a pause time before actually executing the Movicon startup. This 

function can be useful when networking architecture are presents. In some 
case it may be necessary to wait for a few seconds before starting the 
server, so the client can be started up. 
Consider <n> as a number from 1 up to 99 

/A Shows  the project if defined as NT service. 
/On Allows use of another communication socket port. 

This function is useful when the network port used as default by Movicon, 



S Y S T E M  I N S T A L L A T I O N  

Movicon© User Manual 22

is engaged for another application. 
Consider <n> as offset to be added to Movicon standard 2001 port. 

 
 
To give an example, here is the description of a command line to run Movicon in 
Programming mode without opening a new project file: 
 

C:\Program Files\Progea\Mov91\Movicon.exe /N 
 
If you wish to Run Movicon and, at the same time, to Run a previously developed 
project, use the /R parameter. 
Here is the description of a command line for the automatic startup of the Trial.PRJ 
project file: 
C:\Program Files\Progea\MovMe\Movicon.exe /R C:\Documents\trial.prj 

 
Notice : if not specified, the path used is the default path of the system. 
 
 

To add or modify the command 
options or Movicon work directory 
in Windows, proceed as follows: 
If Windows 98 or Windows 
NT/2000 is used, press the right 
mouse button in the Windows 
Desktop workspace and select 
New - Connection. In the 
settings box shown below, enter 
the command line to startup 
Movicon. 
For further information regarding 
use of connection icon properties, 
consult the Windows user manual. 
 

T
he Figure shows the connection settings window. 

 
Suggestions: Before proceeding with programming, create a directory 
and subdirectory for orderly arrangement of objects constituting the 
synoptic and connected logic files. This is obviously not compulsory, but 
will help reading of the system. For example, it is advisable to have a 
separate directory for the Movicon system (proposed by default during 
installation) under which there is a subdirectory for projects and symbols 
library. For better organization and file search, create a subdirectory for 
each project. 

 
Starting up Movicon without command options involves entering the system in 
programming mode with opening of a new project file. 
 
Tips on running Movicon: 

Running Movicon by pressing the CTRL key determines the reset of all the 
Movicon Registries information in the operating system. Use this function when 
you have to reset your system. 
Running a project using the /R option on the line command determines the 
disabling of all the debugging functions. 
If you need to enable the Debugger even if the project is started with 
the /R option, press the CTRL key during the startup.  

 
 

2.4.1. Start the Runtime module only  
Typical Movicon installation provides for the availability of runtime executive module 
only for project start and execution. 
The runtime module is installed under the same Movicon directory and is named as 
MOVRUNTIME.EXE. 
The benefits of using this module consist in a lower space usage on module 
occupied disk, which executes only programs with no editing options.  
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Consequently, the runtime module is to be used by a project start function, using 
the option on /R control line determining the chosen project start, as shown in the 
previous paragraph.  

 
The use of runtime MOVRUNTIME.EXE module replacing the 
MOVICON.EXE is recommended for all events when disk space is 
low (ex. DiskOnChip or Flashdisk). The setup allows installing 
RUNTIME module only, reducing occupied space to a few MB. 
 

2.4.2. Start a project from Windows NT/2000/XP 
The usage of Windows NT/2000 OS requires a few necessary particulars in case a 
project is to be automatically started with PC startup. In fact Windows NT/2000 
obliges the user to execute Log On procedure before executing any operation, to 
satisfy compulsory criteria.  
In case the project is to be started with no OS Log On procedures, use Movicon 
Windows NT Support Services.  
The support to services is warranted using settings to be accessed by the Movicon 
icon on the Windows Control Panel. These procedures are described in a separate 
chapter of this manual. 
 

2.4.3. RunTime module startup on Windows CE 
Installation of Movicon CE involves availability of only the runtime execution module 
for startup and execution of projects. 
The runtime module is installed in the target in the default folder of the application, 
or if otherwise specified during installation, in another folder. The Movicon CE 
runtime is identified by file "MovCE.exe" and simple double click on the file allows 
its execution and selection of the project to be executed. 
The runtime module for Windows CE also needs a license, like the Movicon program 
for desktop; in this case, the license can be of the software type only. When the 
program starts up, if the software license has not yet been introduced, a window 
appears in which, given a Site Code, the corresponding Site Key can be entered to 
release it. 
If the release code is not inserted, the project can be executed in demo mode, 
whereby a warning message appears at fixed intervals. 
A project can be executed in automatic with connection to file MovCe.exe and, 
subsequently, indicating the path, name and extension of the project .prj. 
 

The HPC2000 devices do not have all the memory buffered, only some 
folders are buffered. The volatile information stored is therefore lost after 
a restart.  Therefore, it is advisable to  activate the  "RegSave" 
command after entering the software release code or it will be 
lost.  
 

 

2.4.4. Exit from Movicon 
To exit from the Movicon environment and return to the operating system press the 
EXIT command form the File menu, or the ALT+F4 keys; Movicon will ask to 
confirm or to cancel the operation through a dialog window. 
A running project may have some functions preset to exit from the system when 
requested. 
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2.5. System Protection  
Every Movicon package is supplied with its license against unauthorized use of the 
hardware and software. Two types of protection have been implemented and the 
final user can choose the one most suitable.  
 

1) "SoftKey" Key Code 
2) Hardware Keys 

 
Although both possibilities are available in the Movicon version for Win98/NT/200, 
the product is supplied by default with the LPT hardware, unless otherwise 
requested at the time of the order. In the compact Movicon version for Windows CE, 
in view of the reduced size of these devices, and the impossibility of adding 
hardware components, it is only possible to introduce the softkey option. 
Considerations: the use of dongle allows the client to use a “floating” license easily 
transportable from one PC to another, and independent of problems to the hard 
disk. The softkey option, being a software license, has the advantage of eliminating 
a hardware component and possible risk of loss, theft or damage. 
In both cases all the products purchased with their possible options have a specific 
serial number. 
To display the serial number or the options enabled for the corresponding Movicon 
package, select the “CHECK OPTIONS HARDWARE KEY” command from the File 
menu. The Table shown below will be displayed from which all information can be 
obtained regarding the license. 
 

 
 
 

 
If Movicon does not detect the presence of the Hardware or Softkey at the 
startup, it will be run in Trial Mode.  
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2.6. Dongle (Hardware Key) 
The hardware package includes a dongle that must be of the LPT or USB type. The 
LPT type is provided for connection to the LPT parallel port of the PC. If more than 
one LTP port is present on the PC, Movicon will search in sequence for the dongle on 
the parallel ports starting from LPT1. If a printer is found to be connected to this 
port, disconnect the printer, insert the dongle and reconnect the printer on the 
same protection dongle, which will thus act as the connector. 
The USB type dongle, however, is provided for connection to a USB (Universal 
Serial Bus) port. In this case, because of the type of USB connection, the dongle 
can be installed in any USB port of the PC and can be connected and disconnected 
with the PC switched on. 
If a softkey option is not installed (described further on in this chapter), the 
protection dongle is absolutely necessary for system operation, it enables the 
options and contains a progressive serial number attributed by the manufacturer. 
To display the serial number and options enabled on operation of your Movicon 
package, select CHECK OPTIONS HARDWARE KEY” command from the File 
menu.  
 

USB key installation 
If the USB type dongle is installed, the operating system will request the product 
driver installed the first time. Unless otherwise specified, the driver to be used is 
<skeyusb.inf> and it is located in the Movicon installation subdirectory 
<smartkey\usb> 
 

LPT key installation 
The LPT dongle is normally compatible with parallel ports of all PCs according to the 
existing standards. If the dongle were not visible, a program PARAL.EXE is 
available, which is a utility that allows to set parallel ports in DOS. The scope of this 
utility is to set the protocol on the parallel to ensure correct visibility of the 
SmartKey Dongle independently of the BIOS settings. 
The utility, which has an instruction file readme.txt, is present in the Movicon 
installation subdirectory <smartkey\paral>. 
 

2.6.1. The Network Dongle 
Movicon allows you to use a single hardware key to enable multi-users license for 
the users connected in network, as specified in the sale conditions. 
The network dongle is related to a maximum number of users, where this “floating" 
number is programmed in the key depending on the type of license purchased.  

 
The network dongle must be installed on a station server with Win 
NT/2000 operating system, while the client workstations can be NT or 
Win 98, or 2000 stations. 
The Client PC setting is different according to the Operating 
System: 
- with Windows NT/2000/XP needs to add the Environment 
Variable 
- with Windows 9x needs to modify the autoexec.bat 

 
 

Installation on Ethernet network  
In case of installation on Ethernet network a high security extremely fast 
algorithmic protection mechanism called ANP (Algorithmic Network Protection) is 
activated, which protects Movicon with any type of protocol and server. 
ANP has the following characteristics: 

• Universality : ANP is independent from the network used 
• Key installation :The key can be installed on any pc or server connected 

with the network, irrespective of whether Movicon is installed or not. 
To continue with installation, locate the personal computer on which the key will be 
installed. 
The PC chosen will be called ‘KeyServer’. A special task wil be run on the latter to 
manage the protection depending on the operating system installed.  
 
Steps to follow for the installation: 
; Locate a hard disk shared by all the client connected in network (where 

Movicon is running), for example N:. 
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; On the hard disk located, create a directory of work for the ASKEYSRV.EXE 
program (present in the KeysrvAnp subdirectory of Movicon). The choice of 
the directory name depends on the operator, for example ‘N:\ANP’. Always 
indicate the complete path to allow a correct execution of ANP. 

; Install the ASKEYSRV service correctly. 
; Configure all the PC stations so that the Smartkey installed can be shared. 

 
Installation of ASKEYSRV service on server 

Installation of the service involves the procedure described below: 
1) Correct working of the service requires loading and startup of the 

KEYP.SYS. device 
2) Execution of the ASKEYADD.EXE command for installation, 

configuration and startup of server. 
3) To obtain the user statistics of the SmartKey updated in real-time, 

start up the SKEYMON utility. 
 
During normal operation as well as during error, the service inserts various 
messages in the system log reserved for applications. Use the Event Viewer utility 
available in the menu of Windows NT <Programs/Administrative Tools/Event 
Viewer> for its display. 
 
The ASKEYRM utility will also uninstall the service by de-recording operations. 
 
 

Configuration of the ASKEYSRV service with the TCP-IP-ANP protocol 
The ASKEYADD utility configures the network protocols supported by the  SmartKey 
server. 
Accepts the following parameters: 
-a:<DIRECTORY>Specify the absolute path of the directory shared for temporary 

ANP files. The path specified must have a local directory on the 
server, for example: C:\ANP. Every directory can support a single 
service. In other words, if two services are installed in the 
network, these must have two separate directories. 

-p:<PORT> Specify the TCPIP protocol port 
-t:<TIMEOUT> Specify the time-out for the ANP protocol. If not specified, the 

default value used is 30 seconds. The value 0 disables the 
timeout. 

-c  Cancel the current configuration. 
 
It is necessary to locate the temporary file-sharing directory directly on the 
WorkStation on which the service is installed. A remote directory cannot be used. 
 
The configuration is saved in the Windows register in path:  
"HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\SmartKey Multilan 
Service" 
 
Examples: 
 
 Configuration of TCPIP protocol on port 4000 with timeout of 60  
 seconds:  ASKEYADD -p:4000 -t:60 
 
 Configuration of ANP protocol in directory C:\ANP with timeout of  
 90 seconds: ASKEYADD -a:C:\ANP -t:90: 

 
 

Configuration of Client PC for sharing the key 
The Smartkey key automatically locates the type of network or, to reduce the 
research time, allows you to use an environment parameter(settable with the SET 
command of DOS) called TYPENET: 
TYPENET = Identifies the type of network (Novell or not) : 
 

SET TYPENET = <protocol> 
MESSNET = Defines the message to visualize during the research of the key: the 
default message is     "Waiting server..." 
 
If you do not want to visualize any message, set the parameter with the 
NOMESSAGE. value 
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Setting of the 
Parameters 

Situation 

TYPENET = 
NOVELL 
MESSNET = ..... 

When the application is related to: 
A key installed locally 
A key installed on the Server of a Novell Netware network 

TYPENET = ANP 
MESSNET = .... 
DIRNET = Path 

When the application is related to: 
A key installed locally 
A key installed on the Server of a non Novell network 

 
TYPENET = AUTO 
MESSNET = .... 
DIRNET = Path 

When you wish to have an automatic management of the 
situation (local* key, Novell network, non Novell network). 
This is quite an interesting mode, even if the time to search 
and recognize the key is more important. 
* At the startup, Movicon searches for the key locally; if it 
cannot find it, the research continues on the network using 
the parameter  

 

Example  
Command to execute during the PC startup, for example using Autoexec.bat: 

SET TYPENET=ANP 
SET MESSNET = Enabling on.. 
SET DIRNET=\\Server\server_1\anp 

In this case Movicon will search for the dongle locally and then on the network. 
Searching for the dongle on a non Novell Server, the folder 
\\Server\server_1\anp will be used. 
During the searching operations, the message “Enabling on …” will appear. 
 

2.6.2. General information about the protection key: 
Some recommendations and precautions are given by the manufacturer of the 
Smartkey key - EUTRON that must be followed in order to avoid key troubles 
or faulty functioning: 
 

9 Plug and unplug the key between the PC and the printer only 
when both of them are switched off. 

9 Do not plug the key inside the serial connector because the 
negative voltage can modify the contents of the key or even 
destroy it. 

9 Protect the key against electrostatic discharge. Avoid 
touching the key connector pins to avoid injecting parasite 
electrostatic charges. 

9 Be sure that the PC and the printer are grounded, as required 
by the law. 

9 Avoid exposures to high temperature or sudden rise of 
temperature. 

9 Even if the key is properly installed, external events like 
faults in the PC communication circuits, electrostatic 
discharges of the calculator can cause operating faults of the 
key. 
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2.7. The SoftKey Code  
If not specifically requested at the time of purchase, the Movicon protection can be 

obtained by requesting the 
Softkey. To use the Softkey, 
proceed as follows: 
Install the Movicon software on the 
corresponding PC. 
Make a note of the Site Code (the 
system code related to the PC ) by 
means of the commands described 
below and communicate the same 
to Progea. 
Progea will release the Site key - 
or Softkey - which enables Movicon 
with the purchased options. 
The paragraph below explains the 
procedure for management of the 
Softkey code. 
 
 
 
 
 

2.7.1. Softkey Request 
The Softkey must be requested from Progea only after the installation of Movicon 
because, to perform this operation, Progea (the sales office) must have the Site 
Code, which is the PC code. The Site Code can be read as described above. 
To find it : 

1) Select the command Verify Hardware Key Options from the File menu. 
2) Press the SoftKey button. 
3) You can find the number of the Site Code under the Authorization feature. 

This personal  number is different for each software installation. 
4) Call the Progea Sales office to ask for the Site Key number. 

The Site Key number is linked to the local Site Code. Progea cannot communicate 
the Site key without getting the local Site Code from you. 
If the license has been purchased, the SoftKey will be communicated within 24 
hours after the communication of the Site Code.  
 

2.7.2. Insert the softkey 
When you have received the SoftKey from Progea sales office, insert it in the edit 
box named Site Key in the corresponding window. 
To access this window follow these steps: 

1) Select the Verify Hardware Key Options command from the File 
menu. 

2) Press the SoftKey button. 
3) From the box provided in the Authorization group, insert the softkey 

you received in the Site Key edit box. 
4) Confirm the operation by pressing OK. 

The Softkey is registered in the system and will be activated at the next restart of 
Movicon; Movicon behaves as if the hardware key were present, with the difference 
that, instead of a hardware key, you have a software one. 

 
Warning: Remember that a re-installation of the software on the same PC 
or another PC will generate a new Site Code, which means new Softkey 
codes will have to be requested from Progea again! 
 
Norton Utilities Speed Disk: Unfortunately, the defrag program of the 
speed disk of Symantec’s Norton Utilities moves the system files by 
default.  
 

This means that Speed Disk will also move the coded Movicon files connected with 
the license, causing a loss of the license. To solve this problem, open Speed Disk 
and select the File|Option|Customize|Unamovable Files command, specifying not to 
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remove the files with *.ENT, *.KEY and *.RST extensions. Save this configuration of 
Speed Disk with the File|Options|Customization|Save command, to use Speed Disk 
in the future without problems for your license. 
 

2.7.3. Manual introduction for the Softkey 
To introduce manually or to use Movicon softkey in Windows NT, first install and 
configure the "CrypKey NT Server". After having installed  Movicon and restarted 
the PC, select by Resource Management in e CD-Rom, the "Mov2000" directory, 
enter the CrypKeyNT" directory and launch "Setup.exe" from here. 
During the installation procedure, the installation directory will be required. The 
directory where Movicon has been installed is to be specified (typically, the 
“C:\programmi\progea\MovMe\” directory) 
 
The utility  "Crypkey Server for NT" allows Movicon to access to  Windows NT 
system services to be able to process the  SiteCode and from here the  Sitekey. 
 
In case more Movicon systems are installed (For instance Italian and English) on a 
same PC, specify all relevant installation directories. 
Eliminate or add installation directories by launching from Start menu Programs the 
item "CrypKey Server for NT". All directories configured at the time will be listed on 
CripKey mask. Such directories can be eliminated by "Remove" button or new 
directories can be added by "Add" button. After having pressed the "Add" button 
once, just scroll PC directories until the "Movicon.exe" file is selected. At this time, 
the path where Movicon has been installed is shown in the Cripkey Server box; just 
close this service using the "Close" button to enable it. 
 

2.7.4. Softkey Transfer  
It may be necessary to re-install the software or to transfer the license to another 
pc. Remove the license first by transferring the softkey on Floppy disk and inserting 
the other copy of Movicon. 
NOTE: before carrying out the following operations, make sure the “Cripkey Server 
for NT” program is installed on both machines. 
By defining the two computers as: 

-PC Source: the PC containing the Movicon license 
-PC Destination: the PC to which license must be transferred 

the operations may be described as follows. 
1) Insert an empty floppy disk in the destination pc where you plan to transfer 

the license by means of the "Register Transfer" command in the "Site Key 
Generator License Authorization" window. This window can be accessed 
by means of the "Softkey" in the "Protection key options" opened from the 
"Verify HW Key Options" of the "File" menu. 

2) Insert the floppy disk in the source pc and press the "Transfer Out" button in 
the "Site Key Generator License Authorization".  

3) Insert the floppy disk, now containing the license, on the Destination PC and 
press the "Transfer In" button in the "Site Key Generator License 
Authorization" window. 

4) The license is now transferred to the Destination PC. To put it back again, 
repeat the above operations 

 
 
These are the operations for the license transfer: 

• REGISTER TRANSFER 
• TRANSFER OUT 
• TRANSFER IN 
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2.8. Support to WinNT4, Win200 and 
WinXP Services 

It is well known that the Windows NT/2000/XP operating system does not allow any 
operations if the Log On operation is not validated. The Log On operation must be 
executed as requested by the operating system by pressing the CTRL+ALT+CANC 
keys and by inserting the user with his corresponding password. This means that 
the supervision system of a plant would require the presence of an operator at each 
start-up of the computer, in order to allow the launch of Movicon (even if the launch 
is automatic).  
The applications that support Windows NT/2000/XP services, like Movicon, can 
be executed without executing the Log On operation. This means that the 
supervision could directly play its role at the start of the computer even if the 
operator is not present, by passing the Log On procedure. 
 

 
 
 
 
 
The installation of Movicon under Windows NT 
in fact requires the installation of a particular 
application, Movserv.exe in the Control Panel. 
This can be done by activating the Control 
Panel by selecting the Settings command 
from the Start menu. 
Double click on the Automation Progea 
Services icon; a window will allow you to set 
the Movicon service by means of which it is 
possible to indicate the project to be activated 
as Service.  
By using the corresponding commands as 
described in the next paragraph you can 
perform the required configuration. 
 
 
 
 
 

2.8.1. Declaring a Movicon project as service.  
To declare a Movicon project as Windows NT/2000 service, double-click on the 
Progea Automation Services icon in the Control Panel of the operating system. 
Select the Movicon service from the drop-down list in the settings window, then 
define the project to be launched as service using the <…> buttons and execute 
using the Install command. 
The installation of a project as service can be removed (if not in runtime) by 
selecting the Remove command. 

You can access to the  
Movicon’ 2000 /XP 
Services clicking on the 
related icon in the 
Windows Control Panel. 
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After the project is installed, it is possible to execute the Start command in order to 
activate the service. The declared project will be run automatically without the Log 
On procedure directly on operating system startup.  
The Stop command disables the service, while the Display command displays the 
Movicon project.  
 

2.8.2. Displaying a project declared as service at the startup. 
At the start-up of the Win NT/2000 operating system, if a project was installed as 
service, it is run, but not necessarily displayed on the screen. The operating system 
will display the Log On window.  
After log on by the operator, to display the Movicon project running as service, 
insert a command line in the Start, Automatic Run menu of the OSP applications 
bar. The command line must be according to the instructions given earlier in this 
chapter, making sure to put the option /a instead of startup /R. 
 
Example of command line in the Automatic start group for the display of Movicon if 
installed as service: 
 

C:\Program Files\Progea\Mov91\Movicon.exe /a C:\Temp\Test.prj 
 
If the command line does not allow display of the Movicon project running as 
service, check in the Movicon service to see if the Windows option is active to allow 
the service to interact with the desktop and thereby be displayed by the system. 
This option is activated by default when a project is installed as service by means of 
the Progea Automation Services icon in the control panel; however, the steps to 
check and modify the settings are given below: 

1) From the control panel, access the Windows NT/2000 services by means 
of the Administration Tools system icon, Services. 

2) A window containing all the services present and installed will appear; 
select the Movicon service and display the Properties. 

3) From the window displayed, select the option Consent to service to 
interact with desktop in the Connection tab. 

4) Confirm and close the window. 
 
 

2.8.3. Setting safety policies in a Windows NT/2000/XP 
system 

The protection system of Windows NT 4.0, 2000 and XP makes it possible to 
configure the user groups for which access is limited by criteria established by the 
Administrator. If the computer on which the project is to be executed forms part of 
a network with Windows NT/2000/XP type domain, setting of the limitations of each 
user can be configured in the domain PC, by means of utility tools like 
ActiveDirectory (NT5 OS platform) or the System Policy Editor (NT4 OS 
platform). Otherwise the OS on each machine offers the most limited possibilities 
and the configuration can be done by setting the Local Protection Criteria from 
the Control Panel, Administration Tools. 
In both cases, it is necessary to define a new set of users to which the security 
policies will be applied. For example, users who use the supervision only for plant 
control only need browse through the pages provided by the supervisor; while users 
responsible for administration of the machine can also decide to install applications, 
delete files or carry out other administrative operations. 
In Windows NT a set of users is indicated by the name of Group and limitations can 
be set on this group or operations can be allowed by means of ActiveDirectory or 
System Policy Editor (computer belonging to Windows NT5 domain) or with the 
Local Protection Criteria (computer not belonging to a domain). Refer to the 
Microsoft documentation for a detailed description of rights and limitations that can 
be assigned by means of these two tools, although it simply means identifying for 
each operation, the users or group of users that have the right to execute it. 
All the security configurations to be set will only have any meaning if the Movicon 
application is run as a Windows NT service. The user who logs on will be assigned 
all the policies configured earlier, by the operating system. A project started up as 
service is launched even before the user logs on, and then the operator can check 
to see if the correct command line has been entered for automatic running of 
Windows. For more information about Movicon startup as a service, consult the 
beginning of this charter. 
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2.8.4. Further limitations on a Local Computer 
In the previous chapter, we have 
specified that on each machine, 
the OS allows limited possibility of 
configuring safety policies as 
compared with a computer 
belonging to a domain. Further 
limitations are possible by acting 
on the configuration files, created 
fro each Windows NT user who has 
logged on at least once. It is also 
possible to configure authorization 
for access on each folder or files 
on disk. 
The configuration of limitations of 
access on each folder or files on 
disk is very easy (as shown in the 
figure alongside), by means of 
Windows explore resources it is 
sufficient to display the properties 
and configure authorizations in the 
Safeties tab. 
 
 

 
Authorizations can be 
set on folders or files 
on disk only if the disk is partitioned with the   Windows NT file 
system, NTFS. 

 
 
We have already indicated that other limitations can be defined by modifying 
configuration files of each user. The file is created at the time of first Log On by the 
machine user, therefore it must be checked before proceeding with the operations 
described below. 
The "Documents and Settings" folder of the disk in which the OS is installed 
contains a folder for each user that has logged in at least once and each folder 
contains a hidden file "NTUSER.DAT". The files can be modified using the 
RegEdt32 program that can be activated by means of Run under the Windows 
Start menu. 
This tool makes it possible to load the information contained in the file NTUSER.DAT 
using the Load hive, command, and after the modifications have been made, give 
the Unload hive command to make them active. 
 
The keys to be added or modified for user rights are in two different paths: 
 

• HKEY_USERS\NTUSER\Software\Microsoft\Windows\CurrentVersi
on\Policies\Explorer 

• HKEY_USERS\NTUSER\Software\Microsoft\Windows\CurrentVersi
on\Policies\System 

 
To keep the manual compact, we have avoided listing all the keys in the two paths; 
consult the Microsoft documentation for the complete list, or use the Progea online 
tools like the Knowledgebase. 

 
Important: Incorrect use of the editor of the Windows configuration 
register can cause serious problems, and require re-installation of the 
operating system. 
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2.8.5. Auto LogOn Utility 
Movicon installs a utility, which avoids the Log On procedure, available for users 
requesting any security precaution with WinNT. In this case, to set AutoLogOn, 
launch the Autolog utility listed in the Movicon folder, System Tools in the 
Programs list under Start of the OS application bar. 
The AutoLogOn utility must be activated with an Administrator  and a valid 
password (not null) so that it functions correctly. The use of this utility will not allow 
management of any OS safety, as is otherwise the case by launching the project as 
service. 
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3. The Menu commands 
in Runtime mode 
If made available by the developers, the 
Bar Menu during runtime mode allows 
various operating possibilities. 

The Bar menu of Movicon proposes to the operator - under the title bar - a set of 
commands to interact with the system. The commands proposed are different, 
depending on whether Movicon is in Run mode or in Programming mode. The Bar 
Menu of Movicon is visible unless it has been intentionally hidden for the following 
reasons: 

1) Displaying of the whole screen (CTRL+SHIFT+F5) 
2) The default menu was replaced by a custom menu. 

During the programming of a project, a set of commands is available from the main 
menu.  
The techniques for selecting them with the keyboard or with the mouse are 
described in the previous chapters. 
This chapter contains a description of the consequences of these commands on the 
system. 
The main commands of the bar menu can be executed quickly by using the main 
tool bar described in the next chapter. 
The features of the bar menu can be different according to the active resource and 
the active mode (programming or running mode). This chapter describes the 
commands of the possible features in the menu. Some of them are not available or 
different, depending on the active resource. 
 

 
Menu controls have been preset in order that they display more used 
items only. Used menu can be seen only after enabling the proper 
enabling arrow, which will make the full menu visible in all its items.  
 
 
 
The Movicon bar menu is active even if not displayed. Even if the Full 
Screen command from the View menu is selected, when you click with 
the mouse on the upper border of the working area, the popup menu of 
the corresponding feature appears. 
 

 
 

3.1.1. Pop-up Menu  
Based on a Windows environment consolidated habit, Movicon conceals less used 
items for an easier and intuitive selection of list items.  
 

 
 
To display all menu items, just act on scroll arrows under the list of items and menu 
less used items will be displayed as well.  
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3.1.2. Docking Menus 
Movicon offers the possibility in project settings to enable or disable the function of 
“Docking Menus”.  
These menus allow the operator to drag menu bar on working area position 
preferred. If you do not want to use this function (which will be valid for all menu 
bars) just disable it from project settings, after consulting the programmer.  
 
 

 
 

Particular of project General settings box. 

 
 
 
To position a docking menu where required, drag it with the mouse or double click 
on the menu. To reposition a menu, double click on title bar of menu.   
 
 

 
 

Example of docking menu in a synoptic. 
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3.2.  File Menu  
The commands of the menu File are related to the general use of the project. This 
window shows the features of the menu File in Run mode. During processing of the 
project, not all items available in programming will be available to the operator, as 
indicated in the User Manual. 
 

 
 

If selected, the Features which are followed by …, open a dialog box, which sets the 
corresponding commands. 
To allow a fast opening, you can visualize the name of the last project (or of the last 
4 projects) run. Selecting and activating the name of the project displayed in the 
menu items (if present) will activate the project's Open command. 
 

3.2.1. Print 
 

 

The Print command sends the contents of the active window or 
document to the printer. This command opens a dialog window allowing 
you to set the printing. For more information about these options, refer 
to the "Printing of programs" chapter. 
If you want to print a document different from the current one, first you 
need to select it. 
This command can be selected with the [Ctrl+Uppercase+F12] keys 

 

3.2.2. Print Preview 
 

 

The print preview command allows you to see the document in preview 
as it will appear in print. This command provides access to a display 
area in which some control buttons are available, and the mouse 
pointer, near the print preview, will automatically assume the form of 
the symbol indicating the zoom. For a more detailed description of print 
preview, refer to Charter "Programs printing". 

 

3.2.3. Page Setup 
This command allows you to edit the header and footer for printing. For a more 
detailed description of the page setup, refer to the "Printing techniques" chapter. 
 

3.2.4. Page Layout Setup 
This command allows you to edit the size and borders of the page you want to 
print. For a more detailed description of the page setup, refer to the "Printing 
techniques" chapter. 
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3.2.5. Printer Settings 
This command opens a dialog box allowing you to specify all the printer settings. 
For a more detailed description of the page setup, refer to the "Printing techniques" 
chapter. 
 

3.2.6. Project Stop 

 
 
 
 
 
 
 

The display of this control item is determined by the operative status in which 
the system is. If Movicon is under a project processing stage (Run), this item 
will state Stop. The Stop control setting will allow to stop project processing 
and access to its programming. Otherwise, the setting of Run control to be 
executed from programming status, will allow project processing to start. This 
control can also be performed by a control preset by the programmer in the 
project.   
The icon alongside represents the project Run/Stop control from the Toolbar.  
This control can also be performed using the [Alt+F12] keys. 

 
 

 
This control is available only if project has been started from 
Programming mode.  If Movicon is directly started by Run project 
(/R option) this control is not available. 
 

3.2.7. Project Run  
 

 
 
 

The setting of Run control, to be executed form programming status, will allow 
project processing to start. 
The icon alongside represents the project Run/Stop control from the Toolbar.  
Note: The processing status of running project is pointed out by the writing 
(Run) located on the bar or working area heading. 
This control can also be performed using the [Alt+F12] keys. 
 

 

3.2.8. Exit 
This command allows you to exit from Movicon system and to return to Microsoft 
Windows™ operating system. If password management is active, this command 
requires a level 4 password. 
This command will open a dialog box asking you to confirm or cancel the operation. 
This command can also be selected with the ALT+F4 keys. 
A project may require the system exit command by means of a special function or a 
command defined by the programmer. 
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3.3. Edit Menu  
The controls of the Edit menu are related to the use of certain project resources. 
Consequently, available controls will be always depend on the selected resource.   
 

 

3.3.1. Copy 
Based on standard editing methods, the Copy control allows to copy in Notebook 
the text or elements selected currently. This function will be available only if it 
activates a Movicon resource enabling data copying or export.  
Elements copied in Notebook can be later pasted in other project parts or in other 
Windows applications.   
The Copy control, which can be executed also by keyboard with CTRL+C, will not be 
available until the text or object elements are selected.  

3.3.2. Paste 
Based on standard editing methods, the Paste control allows to paste a previously 
copied content in Windows Notebook under resource preset to receive copied texts 
or objects. This function will be available only if it activates a Movicon resource 
enabling data import. Elements copied in Notebook can be later pasted in other 
project parts or in other Windows applications.   
The Paste control, which can be executed also from the keyboard with CTRL+V, will 
not be available until the text or object elements are selected.  

3.3.3. Find 
If available as a consequence of opening a preset resource, the Find control allows 
to specify a character or a 
string of text to be 
searched within selected 
resource.  
Depending on the 
standards, it will be 
possible to specify  if text 
to be searched has to 
match the uppercase or 
lowercase.  In addition 
the direction can be specified within resource by search Up or Down as compared to 

cursor position. The Next button starts 
a new search, whereas the Cancel 
button cancels the search. The Find 
control can be accessed from the 
keyboard with ALT+F3, or, if available, 
from the Main Toolbar, through the Find 
edit box, shown in the figure alongside.  
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3.3.4. Find Next 
After having eventually started a search with Find control, you can search for the 
next specified text using the Find Next control, which can be done also using  the 
key F3. 
 

3.3.5. Select All  
The Select All control allows simultaneous selection of the entire contents of the 
enabled resource, if possible.  
 

3.3.6. Upgrade 
The Upgrade control, available when appropriated resource allows it, forces the 
refreshing of info or data contained in the selected resource box.  
 
 

3.4.  View Menu  
The Menu View commands enable or disable the display of the main displays 
available in the working area. 
 

 
 

3.4.1. ToolBar 
This command allows you to display or hide the Movicon Main toolbar. In Run mode, 
the main system commands can be executed from the tool bar.  

If the mouse is not active, the toolbars will not appear automatically. 
The Toolbars are described in the next chapter. 
 

3.4.2. Status Bar 
This command enables or disables the display of Movicon status in the lower part of 
the workspace area. As well as showing the operating and system messages of 
Movicon, the status bar also gives information about the commands selected from 
the menu or from the tool bar. 
The tick to the left of the item indicates that the command is active.  
For a more detailed description of the status bar, refer to the corresponding chapter 
in this manual. 
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3.4.3. Full Screen 
 

 
This command displays the Movicon working area full screen, hiding the title 
bar, the menu bar and the status bar. 
To return to standard display, press the CTRL+CAPS+F5 keys, or, if the main 
tool bar is present, the corresponding button. 
 
Note: The menu bar will be fully concealed only in case the menu is not 
declared as “Docking” on project settings. otherwise, it cannot be fully 
concealed by “Full Screen” control.  
 

3.4.4. Hyper Full Screen 

 

This command allows you to visualize the full screen, hiding 
the title bar, the menu bar, the status bar and any other 
Movicon system’s window.  The hyper Full Screen command 
can be cancelled using the ESC key or (if the menu has been 
docked) the relative icon kept visible as shown in the picture. 
 

 

 

3.4.5. Zoom 
Programmers using the mouse might want to 
zoom out parts of the working area. 
This command enables the zoom function of 
Movicon. The zoom window can be resized by 
dragging its borders or moved anywhere in the 
working area. It has a zoom out of the area 
pointed by the mouse.  The Title Bar contains 
the coordinates of the mouse pointer.  
The scrolling bar on the right side of the 
window allows you to increase or decrease the 
zoom factor. To disable the zoom window, 
select the corresponding command on the bar 
menu, use the control menu of the zoom 
window or press the ALT+F4 keys. 
 

 
The Zoom tool is available to the operator in runtime if the F 23.0 
standard flag is enabled in the general logic. 
The Page Zoom, for vectorial symbols, is available from Layout Menu. 
 

3.4.6. Historical Log 
This command displays the default Historical Log window of the project.  
The role of the default Historical Log is to record all the events and alarms 
generated by the project in ASCII format. 
The default Historical Log will be displayed in a window in Docking View and can be 
closed with the standard Windows commands, with the corresponding command 
from the Windows menu or with any change of page. 
For a more detailed description of the Historical Log, refer to the corresponding 
chapter in this manual. 
 

The Historic log can however be displayed as set by the programmer in the 
project. 

 

3.4.7. Debug Trace 
The Debug Trace control allows to display Debug Trace system box. This box, 
subdivided into a number of schedules, shows the list of events recorded by the 
system, either in programming mode or in runtime mode. 
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The Debug Trace is a system resource not to be confused with Historical Log, the 
tool for archiving project events, but it is a debug resource to be used together with 
project behavior analysis.  
 

 
 
 
The Debug box is subdivided into the following boxes: 
 
System: Archive directory of system logged events 
Default: Archive directory of events to be used by logic executions, to be defined in 

programming.  
OPC Client: Archive directory of events to be recorded by interface for OPC Client 

connections.  
OPC Server: Archive directory of events recorded by interface for OPC Server 

connections. 
 

3.4.8. Project 
The Project control will enable display of the application project box. The project 
box contains details useful for the applications project debug. It is available only if 
the project has been started in Run by Programming mode. 
As these debug tools are for the programmer, refer to the relevant chapter in the 
programming manual.  
 
 

3.4.9. General Logic, Synoptic Logic, Project 
This command displays the Debug window of the project (in Run mode) and is 
available only if the project was started from Programming mode. Since these 
commands are specific for the programmer, we advise you to refer to the 
corresponding chapter of the programmer guide for more details. 
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3.5.  Layout Menu  
The commands of the Layout menu refer to the use and the management of the 
vectorial drawings contained in the synoptics and their windows. 
 

 

3.5.1. Default Size 
This command applies the size set in the properties window of the corresponding 
synoptic to the synoptic window, whatever was the size of the window at the 
opening of the screen page.  
 

3.5.2. Fit in window 
This command changes the size of the synoptic window to fit with the external 
container. 

 
The vectorial drawing contained in synoptic will be adopted, depending 
on the dimensions defined in synoptic box properties suited to the new 
set dimension.  

 

3.5.3. Zoom In, Zoom Out, Zoom To 
These resizing commands can be applied to objects or symbols, but not to the 
background Bitmap.  
The Zoom in and Zoom Out functions enlarge or shrink the drawing displayed. 
The Zoom To function allows you to select an area of the synoptic you wish to 
zoom. 
To select the zoom area, click on the first corner, drag the selection with the mouse 
and release the mouse button when you cover the desired area.  
 

3.5.4. Refresh 
The Refresh command regenerates the design. 
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3.6. Settings Menu  
The commands of the menu Settings refer to the use and the management of the 
User’s Password and DDE managements. 
 
 

 
 
 

3.6.1. Log Off User 
This command is available only if the Passwords Management is enabled, and allows 
to log off the active user. 
Please refer to the Password chapter for more information.  
 

3.6.2. Edit User Access Passwords 
This command is available only if the Passwords Management is enabled, and allows 
access to the User’s List. Using this command you can insert or delete the users 
from the list. This commands requires the “System” password level. 
  
 

3.6.3. Restore DDE Links 
This command allows to restore the DDE Links when the communication between 
the two applications fails. Before activating this command make sure that the other 
application linked by DDE is running again.  
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3.7.  Windows Menu  
The commands of the menu Windows refer to the use and the management of the 
windows and of the icons of the Movicon Resources inside the working area. 
The items followed by the "4" symbol indicate that, if selected, the command will 
open another pop-up menu. 
 

 
 
 

3.7.1. Synoptics Configurations  
This command refers to the configuration of the synoptic windows, allowing you to 
open or save a specific configuration. For further information about the synoptic 
configuration, refer to the "Use of the synoptic configurations" chapter in this 
Manual. 

 
This command can be enabled or disabled by the programmer by using the 
standard Flags of Movicon during the execution of the project (Run). 
 

 

3.7.2. Cascade 
This command arranges all the windows in the working area, resizing them to a 
default size and superimposing them from the left upper corner to the right lower 
corner. It is now impossible to return to previous dimensions, except by using the 
configuration windows menu.  
 

3.7.3. Tile 
This command refers to the position of the windows in the working area of Movicon. 
This command opens another menu, which allows you to choose the following 
features. 
The Horizontally feature allows you to arrange horizontally, from left to right, all 
the windows in the working area with the maximum vertical dimension. 
The Vertically feature allows you to arrange vertically, from top to bottom, all the 
windows in the working area with the maximum horizontal dimension.  
It is now impossible to return to the previous dimensions, except by using the 
configuration windows menu.  
 

3.7.4. Arrange icons 
This command arranges all the icons of the windows in the working area 
horizontally. 
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3.7.5. Close all 
This command closes all the windows of the resources currently active in the 
working area of the project. 
 

3.7.6. Other windows 
Displays the available windows related to the project. To open the corresponding 
window, you can select the desired name. 
 

3.7.7. Historical Log 
This command displays the default Historical Log. The default Historical Log records 
all the events or alarms chronologically generated by the project in ASCII format 
files. 
The Default Historical Log will be displayed in a window in Docking View mode and 
can be closed using the same command, using the Windows Standards or any 
command to change the page. For a more detailed description of the Historical Log, 
refer to the corresponding chapter in this manual. 
 

The Historical Log can however be displayed as set by the programmer in the 
project.  

 
 
 

3.8. Help Menu 
The Help menu is marked with the sign “?”, the last command item on the menu 
bar.  
By means of Help, the user can access the system details and online guide, 
provided it is available.  
. 
 

 
 
 

The On Line Guide can only be accessed if the project 
programmer has made controls available, by means of 
the online guide enabling controls in runtime to be set 

by System Flag “Flag Standard 15.7” 
 
 

3.8.1. Index 
If the design engineer makes this control available, it will activate the main index of 
the Movicon OnLine Guide.  
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3.8.2. Search Subject 
If the design engineer makes this control available, it will enable the search of the  
selection box of a specific topic within the Movicon On Line Guide.  
 

3.8.3. Customer Technical Support 
If this control is available, it will enable the page of detail concerning the methods 
of use of the Progea Customer Care Service.  

 
If this item is not available and after-sales service is required, contact 
the plant or application project suppliers. If these are not available, 
contact the Progea After-Sales Service, which will assess your 
requirements and direct you to the nearest Authorized Center.   
The Progea After Sales service addresses can be found at the site: 
Http://www.progea.com 
Or verify the Web addresses on the box accessible from “Info About …” 
box described below.  

 

3.8.4. Info About … 
This is the only control always enabled on the Help menu. By means of “Info 
about…” control, you can access the Movicon system details used, which will be 
helpful for the After-Sales Service required.  
 

 
 
 
 
 
 
 
 
In addition, the Info box also shows the Progea Web addresses and e-mail 
addresses so that the user can use them in case of need or for info on the latest 
versions of Movicon or new products. Two buttons are also available: one for 
accessing the pages of After-Sales Service (provided that guide is available) and the 
other (not available in runtime) for accessing Windows info, by using the MSI 
(Microsoft System Information) system utility. 
 

The MSI utility can be accessed also by Windows system applications 
(Accessories, System Utilities), and is very useful in case details related 
to used hardware, installed OS and other system details are necessary. 
However, this tool is to be used by skilled staff only.  
 

Product Name and 
release number 

Serial Number of the 
License 
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 Example of  Microsoft MSI box for OS and hardware details 
 

3.9. Customized Menu  
Movicon, from Programming mode, allows complete customization of Menu and Tool 
Bar usage. To access the Menu customization, just enable the Customize control 
by double clicking the mouse on the toolbars.  
From the customization box, different setting schedules will be available, which can 
be enabled by clicking on the Tab of every schedule. 
 

3.9.1. Menu Control Customization 
  
From the Control schedule it is possible 
to display the complete list of menu 
controls either available in 
programming and in  runtime. 
The controls and their order cannot be 
changed. 
 
 

 
 
 

 
 
 
 

3.9.2. Customizing Toolbar  
From the Toolbar schedule it is possible 
to display the entire list of Movicon 
Toolbars, enabling their displaying 
using the selection button alongside.  
The default positions of all toolbars can 
be reset by Reset controls. 
New toolbars can be added, but not 
controls. 
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3.9.3. Customizing Menu Tool controls 
From the Tool schedule, it is possible 
to customize the controls available 
from the Tools control menu, 
containing the launch of utility 
applications. 
The Tools menu control can be 
customized by adding new items or 
changing the existing ones. Every 
menu item contains a control line  
(“Command”) with relevant topics, 
which will be executed by a menu 
command. 
From bar tools on upper border of the 
schedule, it is possible to add or 
eliminate items from the Tools menu. 
 

3.9.4. Customizing Menu Use  
From the Menu schedule it is possible 
to customize the system menu display. 
The Project Menu selection is not 
presently active. 
The  “Menu Animations” control allows 
to define the possible type of animation 
to be used each time a menu is 
opened.  
The “Menu Shadows” box allows to 
enable or disable the shadow under the 
menu when it is open. 
 
 
 
 

3.9.5. Option Customize 
Last schedule, Options, allows further customization of the Movicon menus used. 
Selection boxes can be used to set the required style in menu display.  
The Large Icon box allows to enlarge 
icon dimensions of the Toolbars. 
The “Look 2000” box allows to use 
Windows 2000 style in bars and menus. 
The “Show ScreenTips” box allows to 
enable ToolTip (suggestions) when 
mouse is stopped on toolbar icons. 
The “Menu Show recently..” control 
allows to define in menu usage the 
management of menu controls used, by 
defining immediate display of menus 
most commonly used or the most 
recent ones.   
 
 

 
The menu style and look can be set in programming by the Project 
System Settings. 
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4. The Movicon Toolbars 
Movicon has a set of toolbars which 
speed up activation of commands from 
the Menu. 

Movicon allows you to execute the main commands in a fast way by selecting them 
from toolbars containing a set of buttons with graphic identifier.  
The Toolbars can be hidden or displayed by selecting or deselecting them in the 
View menu or in the pop-up menu associated with the mouse right button. 
The Toolbars can be hidden at the start-up of Movicon by using the /T parameter 
on the command string to start Movicon. Otherwise, Movicon will display all the Tool 
bars maintaining the position and the dimensions of the last use. 
 
 
Toolbars are not available by default in Runtime. To enable runtime toolbars, just 
enable the Windows Log “EnableBarsMenu”. This operation requires a password 
level 4 (System).  
 
To perform this, launch Regedit from Windows Execute, then set value “1” in 
“EnableBarsMenu” key located at: 
 
 
 “HKEY_CURRENT_USER” 

“Software” 
“Progea Automation” 

“Movicon Millennium” 
“General” 

 
 
 

 
 

Example of Movicon Tool Bar 

 
To display the function of a command belonging to a Tool Bar, leave the mouse 
pointer on the corresponding button for a while: a “pop-up” text will appear (unless 
intentionally deactivated by the programmer) indicating the related command. 
 

 
On main toolbar there is a button marked by the ▼ symbol. This button 
can be used to access customization of menus as described in the 
previous chapter. 
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4.1. Main Toolbar 
The main commands of Movicon can also be directly selected on the main tool bar 
using the mouse. It may also not be displayed. To display it, select the View – Tool 
Bar - Main command. The following table describes the buttons of the Movicon 
main tool bar.  
 

 

New File  
File Menu, opens a new project file. 

 

 

 
Open File 

 
File Menu, opens an existing project. 

 

 

 
Save File 

 
File Menu, saves the active project file. 

 

 

 
Print 

 
File Menu, Print 
prints the text of the active document. 

 

 

 
Print Preview 

 
File Menu, Print Preview 
Displays the print preview of the document to be printed. 

 

 

 
Cut 

 
Edit Menu, cuts and puts in the clipboard. 

 

 

 
Copy 

 
Edit Menu, copies in the clipboard. 

 

 

 
Paste 

 
Edit Menu, pastes from the clipboard. 

 

 

 
Cancel 

 
Edit Menu, cancels the last editing operation. 

 

 

 
Restore 

 
Edit Menu, restores the last editing operation. 

 

 

 
Open  
Configuration 

 
Windows-Configurations-Open Menu. 
Opens a previously saved configuration window. 

 

 

 
Save  
Configuration 

 
Windows-Configuration-Save Menu. 
Saves the current configuration of the windows inside the working 
area. 

 

 

 
Full Screen 

 
View, Full Screen Menu. 
Hides the menu and title bar. 

 

 

 
Hyper Screen 

 
View, Hyper Screen. 

Maximize the project’s window. 
 

 

 
Run-Stop 

 
File Menu, executes Run/Stop for the active project. 

 

  

 
Guide 

 
Displays and Activates the Movicon guide. 

 

  

 
Sensitive Help 

 
If you click with the mouse button on an object of the synoptic, the 
guide will be automatically positioned on the corresponding subject. 
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4.2. Resource Toolbar 
The commands of the Movicon Resource menu can also be directly selected on the 
resource tool bar. If you want to display it select the View – Tool Bar - Resource 
command. The following table describes the buttons on the Movicon resource tool 
bar. For details, refer to the menu commands. 
 
 
 

 

 

 
New Accelerator 

 
Resource Menu, New Accelerator. 
Inserts a new accelerator resource in the project.  

 

 

 
New Dialog Window 

 
Resource Menu, New Dialog Window. Inserts a new Dialog 
Window in the project. 

 

 

 
New Menu 

 
Resource Menu, New Menu. Inserts a new menu resource in 
the project. 

 

 

 
New Synoptic 
Window 

 
Resource Menu, New Synoptic Window. Inserts a new 
Synoptic Window resource in the project. 

 

 
 

 
New Basic Script 

 
Resource Menu, New Basic Script. Inserts a new basic 
script resource in the project. 

 
 

 
Properties 

 
Resource Menu, Properties. Show the properties window 
of the selected resource. 
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4.3. Windows Toolbar 
The commands of Windows Menu can also be directly selected on the Windows tool 
bar. To display it, select the View – Tool Bar - Windows command. The following 
table describes the buttons on the toolbar. For details, refer to the chapter on menu 
commands. 
 

 

 

 
Cascade 

 
Windows Menu, Cascade. 
Superimposes the windows in the working area. 

 

 

 
Tile 
horizontally 

 
Windows Menu, Tile horizontally. 
Arranges the windows in the working area horizontally. 

 

 

 
Tile vertically 

 
Windows Menu, Tile vertically. 
Arranges the windows in the working area vertically. 

 

 

 
New Windows 

 
Arranges a new window for the active document (under 
preparation). 

 

  

 
Project 
window 

 
Displays or hides the project window. 

 

  

 
Historical Log  

 
Displays or hides the default  
historical Log window. 

 

  

 
Cross-
reference list 
 

 
Displays or hides the cross-reference list window. 

 

 

 
Symbols 
Explorer 

 
Displays or hides the symbols explorer window. 

 

 

 
Debug Trace 

 
Displays or hides the Debug Trace window. 
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4.4. Alignment Toolbar  
The commands for the programmer regarding object alignment (within a 
preselected area) of aMovicon window can be activated, apart from the Layout, also 
using the alignment toolbars with the mouse. The toolbar may not be displayed. To 
display it, select the Display-Toolbar-Alignments command.  
The tool bar remains inactive until an area containing objects or controls is selected.  
To select a window area, click with the mouse left button on the synoptic and hold it 
dragging it to the end of the area; the selected area will appear in a dashed 
rectangle. If the selected area contains some objects or controls, the alignment tool 
bar will be enabled, making its commands available. 
 

 

 

 
Test Dialog Box 

 
Displays the Dialog Box in preview. (Available only from the 
Dialog Window resource) 

 

 

 
Align right 

 
Aligns all selected controls on the right of the main control. 

 

 

 
Align left 

 
Aligns all selected controls to the left of the main control. 

 

 

 
Align Top 

 
Aligns all selected controls above the main control. 

 

 

 
Align Bottom 

 
Aligns all selected controls under the main control. 

 

  

 
Align in center 
vertically 

 
Aligns vertically all selected controls in the center of the 
window. 

 

 

 
Align in center 
horizontally 

 
Aligns horizontally all selected controls in the center of the 
window. 

 

 

 
Set Width 

 
Sets the width of the main control for all selected controls. 

 

 

 
Set Height 

 
Sets the height of the main control for all selected controls. 

 

 

 
Set width and 
Height 

 
Sets the size of the main control for all selected controls. 

 

 

 
Display Grid 

 
Displays or hides the Grid. 

 

 

 
Align to the Grid 

 
Aligns an object to the Grid (even if the grid is not displayed). 
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4.5. The status bar 
The status bar on the lower border of the working area gives the main information 
regarding the operating status of Movicon. 
You can enable or disable it by selecting the Status Bar command from the View 
menu. 
 

 
 
The main status information is relevant to the status of the communication driver, 
the system and the command being executed. 

The Led icon on the right of the bar shows the status of the communication 
driver. A green led indicates that the communication is working properly. A 
red led indicates that the communication is not working properly or that it is 
interrupted. An exact description of the problem will be recorded in the 
historical log.  

The text in the bar indicates the operating status of Movicon or a description of the 
executed command.  

The operating status of Movicon could be, for example, the last alarm or 
message that occurred in the project. 

Note: the status bar, as described in the chapter about the menu of Movicon, can 
also display the texts describing the commands of the customized menus.  

 
 

4.6. The Windows Bar  
The Windows Bar is also displayed in project runtime if the USA item "Tab Windows 
Manager in RUN" is active in the general Movicon settings. 
 

 
 

 
The windows toolbar displays as many icons as there are synoptic windows open; 
by double-clicking on the icon one of the synoptics can be brought to the 
foreground. However, in developing, the windows toolbar helps to move from one 
resource window to another rapidly. 
 
 

4.7. Windows Task bar  
When Movicon is started, the corresponding icon always appears on the right of the 
task bar. 
 

 
 

Example of Task Bar of Windows. 

When you click with the mouse on the icon in runtime, the command associated in 
the general settings is executed, as described in the “Movicon Settings” chapter in 
this manual. In Programming mode, the icon is sensitive to the mouse right button 
and opens a pop-up menu with the main operative commands (Run, …). 
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5. Movicon Project 
This chapter briefly describes the 
operating concept of “a Movicon project”. 

This chapter describes the use of a Movicon project. The methods for opening a new 
project, an existing one, saving, execution in Runtime and simultaneous 
management of a number of projects are described here, The Movicon project is a 
file, (with PRJ. extension) by default, which contains the actual application. 

The project contains the synoptics, the resources, the objects and the 
logics that the Movicon.exe system will execute to supervise and control 
the plant.  

This chapter describes the operations related to the use of the Movicon project. For 
details consult the Programming Manual. 
 

5.1. The project window 
The project window allows you to display, insert or modify resources, objects or 
logics belonging to the project. 
The project windows display the resources inserted in a tree structure. 
The project window has certain characteristic features to facilitate the programmer's 
task.  
On the upper border of the window a set of Tabs allows you to display the resources 
arranged according to type. 
You can select the "Docking View" command from the project window, keeping it 
visible on the left of the workspace, or it can be accessed from the Windows tool 
bar. 
 
 

 
 
 

Tree structure of a project displayed in "docking view" 
and detail for resource schedule selection. 
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5.1.1. Docking view of the project window 
Movicon allows you to “dock” the project window. If you dock the window, it will 
always be present on the left side of the working area in foreground, even when the 
other windows are selected. If the docking view is disabled, the window will be 
represented in the working area like all the other windows and will be displayed in 
foreground when it’s selected. A window can be selected selecting its name in the 
menu Windows. 
The command for the docking of the project window can be selected with the mouse 
right button. 
 

5.2. Open a new project 
When starting, Movicon is set to be in programming mode and set to open by 
default a new Project.  It is thus possible to start programming and to save the 
project at the end by giving it a name of your choice.  
However, should you need to open a new project, select the command New from 
the File menu, or click on the corresponding button as indicated on the bar menu or 
press the keys CTRL+N. 
The opening of a new project always involves the choice of project type to be 
implemented : Small Business Project (small-, medium-sized projects). It 

requires the default marking of all 
resources as Internal resources. 
Enterprise Project instead marks 
them as External resources.  
The working area displays the project 
box with the tree-structured feature 
of resources, as previously shown 
and stated. This box allows to 
proceed with programming of project 
resources as shown in the following 
paragraphs. The box title bar of a 
new project will state the transient 
default name “Project …” followed by 
a progressive number, based on 
number of open projects, also 
previous ones.   
 
 

 

5.3. Opening an existing project 
To open an existing Project, select the command Open from the File Menu, or 
press the corresponding key, or press the keys CTRL+O. 
The above command brings-up a standard dialog box which allows you to select the 
file name you wish to open or select it directly from the available drives and 
directories, according to Windows standards.  
Setting or selecting displays the existing project by means of a dialog window 
similar to that described in the previous paragraph. From this window you can enter 
the new resources or modify existing ones as described in the forthcoming chapters. 
The title bar of the window shows the selected project name. 
 

5.4. Saving a project 
The command that allows saving an active project on disk becomes available from 
the menu or toolbar after the first modification to the project. To save your project 
select the command Save from the File menu and press the corresponding key 
available on the main tool bar, or press the CRTL+S keys. 
To save the project under a name different from the current name use the 
command Save As from the File menu. This command will activate a standard 
dialog box that will allow you to define the path and the name you wish. The 
window will be similar to that shown in the previous paragraph. 
If you want to save a New project, the command Save As will be automatically 
activated. 
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By making adjustments/amendments to the project both the command Save and 
Save As will be activated automatically or in the event you wish to exit or Run the 
project. 
 

5.5. Project Files  
All the data and information regarding a Movicon project are filed with the extension 
.PRJ.  Every time Movicon has to save the project, it always creates a backup copy 
of the previous file containing the last version of the project. The backup copy will 
have the same name as the one of the project but with the extension .BAK. Should 
you for any reason misplace or loose the original project’s file, you can use the 
backup copy (and rename the extension from .BAK to .PRJ). 
To the project, the system also associates other files depending on the configuration 
used. The files will be created in the project directory. 
The Table below contains the explanation: 
 

File Extension 
 

Descriptions 

.PRJ Project File. 

.BAK Backup copy of the project File. 

.CRF Cross Reference File. 

.DVI Communication Driver File.  

.WSP Workspace File (contains the position of the windows in 
the workspace area). 

.TSW Trend Files (contains the settings of the Vectorial 
Trends). 

.FLG, 

.OUT 

.IN 

File containing the value of frozen data when exiting the 
program, value that will also be retained when the 
system restarts.  

.FBK 

.OBK 

.IBK 

File containing a backup of frozen memory areas. When 
one such file is damaged, use the backup file to correct 
the error.  

 

5.5.1. Working Folders of a Project 
If the project uses some external files like Log, Data Logger, symbols, etc., the 
programmer can specify the desired working folder for each external file. Unless 
otherwise specified in the form Working Folders of the menu Settings, the 
working folder will be the project folder, or each file must specify the complete 
path. 
 
For more information, refer to the Settings chapter in the programming manual.  
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5.6. Starting and Stopping a project 
In programming mode the logic and the communication Drivers are not running. 
Conversely, in running mode the logic and communications drivers are active, but it 
is not possible to edit or modify the project. 
If you intend to switch from programming to running mode (or the other way 
round), select the Run command (or Stop) from the File menu, or press the 
corresponding key from the main tool bar or press the keys ALT+F12. 
 

As a rule a project can always be run directly from the 
command line of the Start bar menu (See the chapter on 
System Installation and Configuration). For instance, to run the 
Movicon Project called TEST.PRJ automatically, the command 
line will be: 

 <Movicon.exe /R C:\TEST.PRJ> 
 

If you run a project which has been modified, the system will first ask you to save 
the last update if not already done and then compile the project. If the compilation 
ends without any errors the system runs the project.  
When in running mode, to stop the project and return to programming mode, press 
the same command Stop which was previously displayed as Run from the File 
menu, which appeared before. On using this command (or the quick selection from 
toolbar or keyboard), the system will set itself in project programming mode. 

 
Note: If the password option is activated, access to the 
programming mode will be allowed via a password level 10 
(Developer Level). 
It is important to remember this when you are about to activate 
the password option.  

  
 

5.7. Project Statistics  
Movicon can associate information with each project, allowing you to identify the 
project (the author, the project 
number, etc.). 
This information will be stored together 
with the project and will help type 
identification. As well as the 
information edited by the author, the 
system displays statistical information 
related to the project, like the date of 
the last printing, the date of the last 
modifications, the last save, etc. You 
can display this information by 
selecting the Properties command 
from the File menu. 
 
Note: the properties of a project (when 
Movicon is closed) are available from 
the explorer, by clicking with the 
mouse right button on the project file 
and selecting the Properties feature. 
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6. Working Area and 
Operativity 
This chapter briefly describes the operativity of 
the system and the components of the working 
area. 

The Movicon working area contains the projects  and system resources using the 
windows technique according to the Windows standards. The window with the 
working area can be maximized by hiding automatically the title bar and the menu 
bar or with the corresponding commands. To return to the original configuration 
simply press the CTRL+MAIUSC+F5 keys. 
At the start-up of the project, Movicon might display the icon of the resources 
contained in the project. This means that no Synoptic configuration has been 
defined, as explained later in this section. 
The working area can be maximized, resized or minimized to an icon. 
unless otherwise specified through parameters, at start-up Movicon opens the last 
project saved in Programming mode (or it finds a New project). 
Each project displays the resources of the project in a tree structure in its window. 
For more information about resources and projects, refer to the programmer’s 
manual. 

 
Usually, Movicon is configured by the programmer in order to display at 
start-up the “Main” synoptic configuration. 
 
 

Starting Movicon without parameters in the command line will open the last project 
saved or a new project, as shown in the figure below.  

 
 

 
 

 
The Run or Stop commands in the File menu allow you to switch from 
Programming mode into running mode or vice versa. 
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6.1. Components of a window 
The components of a window are tools allowing you to work with the window, with 
the application or with the drawings inside the window. All the windows have some 
common elements, like the title bar and the control menu. The dialog windows can 
be different, depending on whether they are dialog windows of the system, of the 
project, or of the properties. To simplify all the types of dialog, the windows will be 
simply named Dialog Window.  The main window of Movicon contains the menu Bar, 
as well as all the secondary windows (if present). 

The main bar menu of Movicon can be customized by the programmer in 
order to correspond to the application. 

A secondary window can have its own title bar, except if the settings disable it or if 
it is maximized. In fact, if maximized, the window shares the title bar of the main 
window. 
 

 
 

The elements of a window. 

 

6.1.1. Control menu Icon 
The control menu icon is in the upper left corner of each window. The control menu 
is particularly useful when you work without the mouse. The commands of the 
control menu allow you to resize, move, zoom in, zoom out or close the window. To 
open the control menu, click with the mouse on the corresponding icon or press the 
ALT key.  
By double clicking on the icon of the control menu, the window will be closed or 
reduced to an icon.  
 

6.1.2. Title Bar 
The Title Bar displays the name of the window or of the Movicon project.  

• To save video space, it is sometimes useful not to display the title bar. 
• The title bar can be displayed or hidden by selecting the corresponding 

command from the View menu or by pressing the CTRL+MAIUSC+F5 
keys. 

• The display of the title bar of a synoptic window is set by the project 
programmer. 

If more than one window is opened, the title bar of the active one is different from 
the other ones in color or intensity. The active window is the window in which you 
are working. To activate a window, simply click on it or press the CTRL+TAB keys. 
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6.1.3. Menu Bar 
The Menu Bar lists the available menus, each menu containing a set of commands 
or operations to perform. The features of the different menu change with the type 
of window. 

The menu of a project can be customized by the programmer and the 
system commands can be replaced by the operating commands of the 
project. 

 

6.1.4. Scrolling Bars 
With the Scrolling Bars, you can display windows, which have a size greater than 
the screen. 
They can also be used to display the elements of a list which do not fit in the 
predefined area. 

Note: when the contents of a window are wholly displayed, the scrolling bars 
are not visible or they are grey. 
 
Tip: Movicon allows rapid scrolling of images of a synoptic by pressing the 
right mouse button and dragging the image to the required point.  

 
 

6.1.5. Maximize Button 
Using the mouse, you can click on the Maximize Button to maximize the active 
window or on the Minimize Button to reduce the window to an icon. 
After pressing the Maximize Button, the Maximize button is replaced by the Back 
Button, which allows you to restore the previous dimensions of the window. You can 
do the same by selecting the RESTORE command from the control menu. 
 

6.1.6. Border of a window 
The border of a window is the outer margin of the window. You can increase or 
decrease the border of a window by clicking on it and dragging it with the mouse. 
 

For the synoptic window, this option is only given to the programmer. 
 
 

6.2. Use of the windows 
The opportunity to work with more projects or resources together determines the 
opening of more windows at the same time. This chapter briefly explains how to 
move, resize or scroll the contents of a window. Since these commands belong to 
the Windows Standard, we advise you to refer to the Windows User Guide for more 
details. 
 

6.2.1. Moving a window 
You can move a window (synoptic, dialog, etc.) to another place of the screen by 
dragging the title bar of the window to the desired position. The profile of the 
window will follow the mouse pointer to indicate the position. 
Using the keyboard, select the desired window (press CTRL+TAB to switch from one 
window to another); press ALT, Dash (-) to open the control menu, select the 
MOVE command from the control menu (the pointer has the shape of 4 arrows 
joined together); use the arrow keys on the keyboard to move to the desired 
position and finally press ENTER. 
 

6.2.2. Resizing a window 
Sometimes it can be useful to resize the displayed windows, as long as this 
operation was enabled by the programmer. Using the mouse you can resize a 
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window by dragging the borders or the corners of the window. Using the keyboard, 
select the desired window (press CTRL+TAB to switch from one window to another); 
press ALT , Dash (-) to open the control menu, select the RESIZE command from 
the control menu (The pointer will have the shape of 4 arrows joined together); use 
the arrow keys on the keyboard to move the corresponding border to the desired 
position and finally press ENTER. 
Note: The minimum size of a window is usually 5 x 2 cm., depending on the screen 
resolution.  
 

6.2.3. Minimizing a window 
You can reduce a window to an icon to partially free the screen, provided that the 
operation was enabled by the programmer. By minimizing a window you can clear 
some memory in the pc or reduce Movicon processing work. The programmer is 
allowed to opt for unloading memory on the PC while the window is reduced to an 
icon, as described in the programming manual. 
To minimize a window to an icon, double click on the corresponding button in the 
upper right corner of the window.  
Using the keyboard, select the desired window (press CTRL+TAB to switch from one 
window to another); press ALT, Dash (-) to open the control menu and select the 
Reduce To Icon command from the control menu.  
 

6.2.4. Restoring the size of a window 
To restore the size of a window reduced to an icon: 
• Using the mouse, double click on the icon or choose the RESTORE command 

from the control menu. 
• Using the keyboard, select the icon by pressing the CTRL+TAB keys, until the 

icon or the desired window is selected. Then, press the ALT+Dash keys to open 
the control menu and select the RESTORE command. 

To restore the size of a maximized window, click with the mouse on the restore 
button in the right upper corner of the desired window, or select the RESTORE 
command from the control menu. 
 

6.2.5. Maximizing a window 
Usually, a window can be maximized to occupy the full screen. To maximize a 
window, click with the mouse on the corresponding button in the right upper corner 
of the window or double click on the title bar. 
Using the keyboard, select the desired window (press CTRL+TAB to switch from one 
window to another); press ALT, Dash (-) to open the control menu and select the 
Maximize command from the control menu.  
Following these instructions, the window will be maximized and the Maximize button 
will be replaced by the restore button. Later in this manual we will describe how to 
hide the tool bar and the title to occupy the full screen.  
Note: When one of the windows is maximized in a project, remember that the 
others are still open behind it even if they are hidden.  
 

Tip: Experience tells us that the programmer has to be careful about 
leaving the inexperienced operator the liberty to resize the windows 
of a project, as this could create problems. To prevent this, Movicon 
allows the programmer to limit the resizing of each window in the 
programming phase and to save the configurations, as described in the "Use 
of the windows configurations” chapter. 

 

6.2.6. Docking of the project window 
The project window of Movicon can be "Docked", that is kept in the foreground on 
the left side of the working area. This allows you to work with other windows 
(synoptics, resources, etc.) in programming or in debug mode, keeping the system 
information visible. 
To dock or undock the project window, select the Docking View command from the 
View menu or with the mouse right button. 
The Docking is deactivated using the same command. 
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6.3. Use of the Scrolling Bar 
Some windows have scrolling bars (vertical or horizontal) that can be displayed to 
allow you to view some information or drawing which is hidden outside the visible 
window area.  
To scroll the display of a window, click with the mouse on the scrolling Up and Down 
arrows, click above or under the scrolling box, or drag the scrolling box. 
Using the keyboard, press the Arrow up, Arrow down or PageUP, PageDOWN keys 
(to scroll vertically). 
Note: when the contents of a window appear entirely, the scrolling bars are not 
visible or are grey.  
 

Tip: to scroll quickly through the contents of a synoptic window, click with 
the mouse right button inside the window and drag the window to the 
desired position.  

 

6.4. Use of the Menus 
The main commands of Movicon are listed in menu. Each resource has its own 
menu automatically displayed on the main bar menu on the upper border of the 
working area. 
Remember that the main commands can also be activated with the mouse from the 
tool bar, as described in the corresponding chapter.  
Moreover, each window has a control menu, also named system menu. This menu 
can be opened by clicking on the icon on the upper left corner of each window. For 
more information, refer to the "Use of the control menu " chapter in this manual”. 
 

As well as the main menu, Movicon supports the mouse right button. If you 
click with the mouse right button a pop-up menu is displayed, including 
some commands regarding the area or the pointed resource. 

 

 
 

Example of a list of commands in the main menu.  

6.4.1. Selecting and closing a menu 
To execute the main commands, you must select the corresponding command from 
the menu. The selection of a command launches the corresponding operation 
directly. 

• Using the mouse, point the feature of the menu bar, click on it with the 
mouse left button to open the menu and click on the desired feature to 
execute the corresponding command. You can also drag the cursor to the 
required item, then release the mouse button. 
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• Using the keyboard, press ALT to select the menu bar (the control menu 
will be highlighted) then press the LEFT or RIGHT arrows to select the 
correct menu, press ENTER to open it and the UP and DOWN arrows to 
reach the desired command. Finally, press ENTER to execute the 
command. To interrupt the sequence, press ESC repeatedly, until you 
exit from the menu bar.  

 
Tip : If an underlined letter appears in the name of a menu, you can activate the 
menu directly from the keyboard by pressing the ALT key followed by the 
underlined letter. 
 
Movicon uses some conventions for the menus, described below, established by the 
Windows Standards: 
 
 

Greyed Feature The command cannot be selected at this stage of the 
operations. Select another item before using this 
command. 

 
Arrow (  ) : 

Menu expansion control. If menu contains other 
infrequently used items, they can be displayed by 
acting on arrow.  

Dots  (...) When the command is selected, a dialog window 
containing the option required to execute the command 
appears. 

Tick (9) The command is currently active. If selected again, it 
will become inactive and the sign will disappear. 

Combined keys The right side of the menu features usually specifies a 
set of combined keys, which allow fast selection using 
the keyboard (as long as the same keys are not used 
by the Movicon project). 

Arrow (  ) : 
 

When a feature of a menu followed by a black triangle 
is selected, another pop-up menu with another set of 
commands appears. 

 
 

6.5. The control menu 
Each Movicon window, if not disabled by the programmer, has a control menu, 
which can be opened by selecting the icon on the upper left corner. 
The control menu of the windows is different from the 
dialog windows one, as described below. 
To open the control menu, click on the icon on the upper 
left corner of the window. Be careful not to double click: 
this would close the window or reduce it to an icon.  
Using the keyboard, press ALT+SPACE BAR to activate 
the check box in the main window or ALT+Dash (-) to 
open the control menu from the active secondary 
window. This will select the box. To close the control 
menu without selecting any item, or to unselect the box, 
press ESC.  
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6.5.1. The Commands of the control menu 
The following is a description of the main commands of the control menu; for more 
information, refer to Microsoft Windows user guide. 
 

Restore: Restores the original size of a window after it was maximized. 
 

Move:  Allows you to move a window to another position using the 
keyboard arrow keys. 
 

Resize:  Allows you to modify the dimensions of a window using the 
keyboard arrow keys. 
 

Iconize: Reduces the window to an icon. By pressing ENTER on the 
icon, the original dimensions will be restored. 
 

Maximize:  Maximizes the window or the icon to the maximum size. 
 

Close:  Closes the window. This command can also be executed by 
double clicking with the mouse the icon in the upper left corner 
of the window on the control box.  
 

Next Switches to the next window opened in the working area. 
 
 

6.6. Use of the pop-up menu  
A Movicon project can contain some pop-up menu that are activated with a 
command predefined by the programmer by using a button, a key, or a hot region. 
To execute a command from a pop-up menu using the mouse, simply click on the 
desired feature. Using the keyboard, simply use the UP and DOWN arrow keys to 
scroll the feature and ENTER to select the desired one. 
 

The commands associated with these custom menus can be chosen freely by 
the programmer. Therefore, for relative information, consult the specific uses 
of the project. 
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7. Screen Pages and 
synoptic Configurations 
A Movicon project bases the graphic 
interface on screen pages, which 
comprise the project Synoptic resources. 

In a Movicon project it may be essential to use the Synoptic Configurations. For 
Movicon a synoptic configuration corresponds to a screen page consisting of one or 
more synoptic windows, sized as described above to the optimum size and arranged 
in a logical, orderly manner on the screen. 
The Movicon page change commands which can be associated with objects always 
refer to the Synoptic Configurations, i.e. the project’s screen pages. 
The synoptic configurations can be activated by the operator (if permitted by the 
programmer) at any time by clicking the mouse on the relevant button on the main 
toolbar or by selecting Configurations then Open from the Windows menu.  

• The project programmer normally allows synoptic configurations to be 
activated using commands that are simple and intuitive for the operator, 
using from customized buttons or icons, by clicking with the mouse on 
special hot regions in the synoptic, from the keyboard or even upon 
decision of the logics.  

If the project allows, the synoptic windows can be sized and moved as desired by 
the operator. 
For example, screen pages can be arranged with two independent synoptics, with or 
without displaying the Tool bar or the Status bar. After the page has been formed, 
it can be saved as a Synoptic Configuration with a name and an identifier.   

• The name allows the screen page to be called up using a Movicon 
command or object. The identifier allows the page code to be called up 
according to an event established by the plant or the project. 

When you call up a screen page, it will appear exactly as it was when saved, 
adapting the toolbars to the screen. 
 
 

 
 

The Synoptic Configuration window (Screen Page) 

 
Use of the Synoptics Configurations is advisable if not obligatory and has the 
following advantages: 
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• It allows you to associate an Accelerator resource (i.e. a series of keyboard 
commands) with each screen page, thereby allowing the same function keys to 
be used for different purposes within a project. 

• It allows project screen pages to be called up and activated upon the operator’s 
command or upon an event established by variables. 

• It also permits the screen pages to be structured and organized in the best way 
for the operator, if necessary preventing him from opening or leaving open the 
project synoptics, which would unintentionally impair performance of the 
system. 

 

7.1.1. The “Main” Synoptic Configuration  
Movicon is set-up in such a way that when it starts, it will look for and display the 
Main synoptic configuration. If this configuration is not present, Movicon will start-
up with all the project windows minimized. The operator can then double-click the 
required icons to open the synoptic windows. 
 

7.1.2. Enabling the Open and Save Configuration Commands 
The Configurations - Save and Open commands are available from the Windows 
menu in the following conditions: 
 

1) Always, in development system programming mode. 
2) Only if checked, during project runtime. The programmer can enable 

them by setting the appropriate Flags (F15.4 and F15.5) in the General 
Logic.  

 
These commands are disabled unless otherwise specified. 
 

The Configurations submenu can be accessed from the Windows menu if general 
logic is enabled (see Standard Flags). Thus the Save command will be available for 
saving the current screen page, or Load for activate a Configuration saved earlier. 
 

7.1.3. Saving Synoptic Configurations 
Before being able to display a screen page in the project, the Synoptic 
configurations must first be saved. 
The Configurations - Save command from the Windows menu is used for saving 
the current situation in the workspace and hence the configuration of a single 
window or all the synoptic windows present in their current sizes.  
You must give the configuration a name by typing it in the Configurations Name 
edit box. 
By way of the general logic, the configuration’s ID number provides an identifier for 
activating or reading the configurations from the logic or from the PLC.  If you do 
not intend to use this option, this number will not affect the configurations. 
If you enter a configuration name that already exists in the project, you will be 
asked to confirm overwriting. 
 
Bear in mind that the Configurations - Save command saves the setting for all the 
open synoptic windows, even if they are not displayed. Before saving, check that 
the synoptic you intend to save is the only one open so as to avoid pointless 
wastage of system resources. 
 

 
 

Window for saving a Movicon synoptic 
configuration 
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Note: The configuration name Main is to be considered a special 
name because it is used by Movicon to identify the synoptic 
configuration displayed at the start of project runtime. Remember 
that Movicon names are case-sensitive.   
 

7.1.4. Opening Synoptic Configurations 
Synoptic Configurations must previously have been saved in order to be opened and 
displayed. Only in this case will the page appear in the list of available and openable 
pages. 
The Configurations - Open command from the Windows menu activates a 
previously saved configuration. You can use the relevant selection window to scroll 
through the currently listed configurations, preview their contents and activate the 
required configuration by double-clicking the name with the mouse or by clicking 
the Load button.  
The new window configuration will now replace the one previously displayed in the 
workspace.  
 
 

 
 
 
The Delete button, which is activated when a configuration is selected, allows the 
required synoptic configuration to be removed from the list. The removed 
configuration will no longer be available, but if necessary it can be restored using 
the Save function. 
The preview image will display the synoptics and menu bars for the selected 
configuration. 

 
Note: Movicon’s synoptic configurations can also be opened using specific 
commands set by the programmer for this purpose. This means that in a 
project you can change page using buttons, Hot Regions or keyboard 
commands. 
 

 

7.1.5. Transparent Boxes  
The Windows 2000 environment may use transparent boxes. A transparent box 
offers the operator the possibility to exploit transparency level to keep the below 
box content as displayed, by exploiting the transparency level of forefront box.   
 
The transparency level can be set on project General Settings, which can be 
accessed by the programmer.  
 

 

 



S Y N O P T I C S  C O N F I G U R A T I O N S  

Movicon© User Manual 72

 
 
 



W I N D O W S  A N D  O B J E C T  

Movicon© User Manual 73

8. Using Windows and 
Objects 
This chapter briefly describes the use of 
the synoptic windows and of the objects 
contained inside them. 

8.1. Using a synoptic window 
Apart from graphic animation, the synoptic windows can contain some predefined 
objects, which allow the operator to interact with the plant. 
The available objects that can be inserted in a synoptic window are: button, the 
switches, the potentiometers, and Spins 
 

Moreover, you can prearrange some areas so that a click above the area executes 
a predefined command. These areas are named Hot Regions and can be set with 
the Hot Region object. In run mode, the cursor changes its shape when it is above 
such a region. 
 

The commands associated with the objects are chosen by the programmer and are 
specific for each project. 
The next paragraph will describe the use of the Movicon object when inserted in a 
project for the control of the plant.  
 

 
 

Example of synoptic containing command objects 
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8.1.1. Using a TouchScreen 
It is often necessary to install the software application on machines without a 
keyboard, which use a TouchScreen as pointing device. 
Obviously, the programmer has to take into consideration the fact that there is no 
keyboard and that special procedures are 
required to allow the operator to type in 
numerical or alphanumeric values. The 
operations normally performed with the 
mouse are not affected. 
To speed up operations and allow the 
programmer provide a simple and easy-to-use 
interface for machines without a keyboard, 
Movicon uses special commands, which allow 
a "Virtual Keyboard" to be used. This is a 
software keyboard that allows the operator to 
type in the required values by bringing up the 
keyboard (NumPad or Alphanumeric) only 
when necessary. 
This opportunity is provided by the following 
commands available from the Command 
Type list that can be selected from the 
Execution Properties of any object or 
resource set up for the command:  
 

8.1.2. Synoptic Buttons 
A synoptic window can contain one or more Movicon buttons. 
Movicon buttons can have different shapes as well as different functions.  
 
 

 
 

Some of the buttons available. 

 
 
The command associated with a Movicon button can be directly activated with the 
mouse by clicking on its surface. If the mouse pointer is close to the button in its 
command area, the button is highlighted. If the mouse is not available, you can 
select a button by using the TAB or UPPERCASE+TAB keys repeatedly. Once the 
button is selected, you can activate it by pressing the ENTER key, or by simulating 
the left button of the mouse with the SPACE BAR. 
 

8.1.3. Typology of the button objects 
The Button can be set as latch, impulsive, timed.  
Once the button is selected, you can simulate it by pressing the Left Mouse button, 
or using the keyboard with the Tab key to select the button and the SPACE BAR to 
activate it. The available types of buttons are: 
 

Normal: if you select this option, the button will be depressed all the 
time the left button of the mouse is held down and will be released when 
the button of the mouse (or its keyboard equivalents) is released. 
Latch: if you select this option, after the button has been activated using 
the left button of the mouse, it will remain in this position until you press 
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the left button of the mouse again to return to the previous condition (bi-
stable effect). 
Impulsive: if you select this option, once the button has been activated 
it will automatically return to the basic position after the time (in 
milliseconds) set in the edit box next to the Impulsive box even if the left 
button of the mouse (or its keyboard equivalent) is held down. 
Timed: if you select this option, once the button has been activated it 
will automatically return to rest position after the time (in milliseconds) 
set in the edit box next to the Time box. 

Note: The command associated with the button will always be activated after 
releasing the left button of the mouse or the SPACE BAR. 
 
 

8.1.4. Potentiometers 
A synoptic window can contain one or more Movicon potentiometers. 
The Movicon potentiometer can have different shapes as well as different functions; 
they are normally used to preset the values or set-points of the plant. 
 

 
 

Example of  Sliders and Potentiometers 

To use a potentiometer, you should point its cursor with the mouse, press the 
mouse left button, drag the cursor to the position of the cursor value with the value 
you want to set and release the mouse button. Using the keyboard, select the 
desired potentiometer with the TAB key, use the Up and Down arrow keys for a 
precise tuning and PageUP, PageDOWN for a rough tuning. 
 

8.1.5. The Spin Button 
A synoptic window can contain one or more Movicon spin buttons. 
The spin buttons are usually associated with display objects and are used to 
increase or decrease the values of the plant set-points, like the sliders.  
 

 
 

Example of spin object associated with a display 
window 

 
 

8.2. Modifying a Variable 
If set by the programmer, some objects or resources (button, menu, commands 
from keyboard, etc) can activate a command which allows you to modify the value 
of the variables of a project. 
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This command will open a system window for the selection of the desired variable 
and the editing of the value. At the end of the setting, simply confirm the operation 
with the ENTER key or cancel it with the ESC key. 
 

8.2.1. Modifying the Variables using the Display object 
A display object is normally used to display the value of some variables, but if there 
is one, a Display can allow you to modify the value of the variables it is associated 
with.  
To modify the value, click with the mouse on the digits of the display: they will 
appear in a different style; digit the value you want to set and confirm with ENTER. 
The value will be sent to the variable associated with the Display. The ESC key 
cancels the operation.  
 

It is also possible to click on the display; with the right button of the mouse 
select the edit command and digit the value in the corresponding edit box. 

 

  
 
 

8.3. Hot Region (Sensitive Zone)  
The Hot Region of a synoptic is a mouse-sensitive, delimited area of the synoptic, 
since it can be associated with a command predefined by the programmer that is 
activated by a single click of the mouse above the area.  
 

* 
The borders of the area are totally invisible. The only way for the operator 
to know that he is above a hot region is to notice the change in the mouse 
pointer (which becomes as in the figure on the left). 

 
To execute the associated command, simply click on the area when the mouse 
pointer changes; when using the keyboard, use the arrows to go above the hot 
region and then press ENTER or the SPACEBAR when the mouse pointer changes.  
 

Note: The arrow keys are available only when another object of the synoptic 
is not selected. To deselect an object, press TAB or UPPERCASE+TAB. If you 
do it repeatedly, you will select the objects one after another until no object 
is selected. By pressing TAB again the first object of the synoptic will be 
selected. 
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8.4. Use of a Dialog Box 
The dialog window is used as a user interface to allow the operator to interact with 
the system and to insert the data needed by the process. The dialog window can be 
emitted by the system or by the project. The dialog windows emitted by the project 
were deliberately created by the programmer to be used in the management of the 
process. The handling of dialog windows will be described later in this section. 
 

 
 

Example of dialog window for a simple recipe 
management. 

8.4.1. To move inside a dialog window 
It is often necessary to move the cursor position inside the dialog box to select one 
or more options. When an option is selected, it will be surrounded by a dashed 
rectangle or by a selection cursor.  
To move inside a dialog window, click with the mouse on the desired option or on 
the corresponding area. 
Using the keyboard, press the TAB key to move forward (generally from left to 
right) or UPPERCASE+TAB to move backwards. Or, if you want to move faster, keep 
the ALT key down and type the underlined letter present in the title of the option or 
of the group.  
Inside an area, use the arrow keys to move from an option to another. 
 

8.4.2. Closing a dialog window 
Usually, every dialog window contains at least two buttons for closing the window: 
one to exit without saving (usually named Cancel) and the other to exit saving and 
activating the data (usually named Ok or Enter). With the keyboard, you must 
press the ESC key in the first case and the ENTER key in the second. 
Anyway, if these buttons are not present, the dialog window can be closed by using 
the Close command from the control menu or by using the ESC key. With the 
keyboard you can also close the active window by using the ALT+F4 keys. 
With the mouse, you can close the window by double clicking on the control box in 
the upper left corner of the window. 
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8.5. The controls in the dialog box 
Different types of controls can exist inside a dialog window. A complete description 
of them is available in the programmer manual in the chapter about the dialog 
windows.  
The different types of controls in a dialog window are: 
 

8.5.1. Edit Box 
In an Edit box, you can type information. When you move to an empty text box, a 
blinking bar appears on the left side of the box. This bar is called insertion point and 
indicates that the inserted text will be displayed starting from this bar.  
If the edit box already contains some text, this will be automatically selected and 
replaced by any new text typed; otherwise, you can scroll it with the keys and 
modify it as desired.  
 

 
 

Edit box combined with a Text box. 

 

8.5.2. List box 
A list box displays a list of features available for a selection. If the list is too long to 
be contained inside the list box, the scrolling bars will appear. The features of a list 
box can be selected with the cursor bar or with the mouse one at a time. 
To enable the selection, use the scrolling bar and double click on the corresponding 
feature, or scroll the list with the arrow keys and press ENTER when you are on the 
desired feature.  
 

 
 

Example of standard List Box 

8.5.3. Combo Box 
The combo box looks like a rectangle containing the voice selected. If you select the 
arrow on the right side of the rectangle, a list box containing the available voices 
appears. If the list box is too narrow to display the complete features, the scrolling 
bars are displayed. This type of edit box is typically used inside small dialog 
windows. To open the list box, press the button with the right arrow design or press 
the ALT + Down arrow keys.  
To activate the selection, use the scrolling bar and double click on the desired 
feature, or scroll the features using the arrow keys and press ENTER when you are 
on the desired feature.  
 
Note: You can select one voice at a time inside the combo box. In some cases, you 
can select more voices at a time; to do this, follow the next steps:  
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Click on the first desired feature; then keep the Uppercase key or CTRL key pressed 
and click on the last desired feature. At the end, release the Uppercase or CTRL 
keys. To cancel the selection, click on any feature. Using the keyboard, use the 
arrows to select the first feature, then press the uppercase key and, at the same 
time, use the Up and Down arrow keys to select all the desired features.  
 

 
 

Example of Combo Box 

8.5.4. Radio buttons 
The radio buttons have a set of options, but only one of them can be selected. The 
selection of one option automatically cancels the selection of any other option of the 
group. The active option is enabled. 
To activate an option, click with the mouse on the desired radio button. 
Using the keyboard, press the TAB key to move on the desired option set and then 
use the arrow keys to select the desired radio button. 
If an underlined letter appears in the name of the option, it is possible to select the 
desired option quickly, keeping the ALT key pressed and pressing the underlined 
letter. 
 

 
 

Example of radio buttons 
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8.5.5. Check box 
The check boxes represent options that can be selected or deselected, even with 
other options of the same group. An active check box contains an X inside.  
To activate a check box, click on it with the mouse or using the keyboard, press the 
TAB key until you reach the desired check box and use the SPACE BAR to activate 
or deactivate it.  
If an underlined letter appears in the option name, you can select the option quickly 
keeping the ALT key pressed and pressing the underlined letter. 
 
 

 
 

Example of check box 
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9. Alarms and Messages 
The alarms and messages in a project 
allow you to monitor and to display any 
event which appears during the process. 

Movicon allows you a management of the alarms which is completely settable and 
separated from message management. The alarm management allows the 
programmer to assign one of the five priority levels existing to each alarm.  
The display of the alarms or messages can be decided by the programmer, since he 
can insert a Movicon object named Alarm or Message window in any synoptic 
window or video page. 
 

The display of an alarm or message window is not defined rigidly by the 
system but is defined by the project developer using one of the many 
possibilities offered by the system to adapt the project to the various 
functional and aesthetic requirements of the client or plant.  

 
The display of the alarm or message window can be associated with a button, a 
function key, an icon or an event. The alarm or message windows can be configured 
by the programmer as desired. This chapter will describe all the options and 
possibilities given by the alarm and message windows. 
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9.1. The alarms window 
The alarm window of Movicon, depending on how it was configured in the project, 
allows the operator to perform a complete management of the plant alarms. The 
window, whose size was defined in the project, allows you to visualize the alarm 
present in the plant or in a restricted area of the plant. 
Each alarm can be associated with: a description, a priority, information about the 
time it appeared, the acknowledge time, comments, etc …). 
Remember that this information is available only if enabled by the programmer. 
 

 
 

Synoptic containing an alarm window with the menu 
enabled by the mouse right button. 

9.1.1. Select the Alarm area 
An alarm window can display all the alarms of a plant or only a set of them, 
arranged by areas defined by the programmer. 
If an alarm window is dedicated to 
displaying area alarms, the programmer 
can set the window to let you choose and 
change the displayed area. If necessary, 
the operator can select the desired area, 
by clicking with the mouse right button 
on the windows and selecting the Select 
Area command. The next selection 
window will appear: 

 
 
The available areas are the ones predefined by the programmer, listed in the 
combo box "Area". 
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9.2. Using the alarm window  
Before selecting any command button in the alarm window, you must select one or 
more alarms. To select only one alarm, simply click on the corresponding alarm 
while, to select more alarms, keep the CTRL or Uppercase key pressed and click on 
the desired alarms. 
If the mouse is not available, select the alarm window with the TAB key and use the 
Up and Down arrows to select the alarm inside the alarm window. To select more 
alarms, keep the Uppercase key pressed and use the arrow keys. When the alarms 
are selected, use the TAB key to select the desired command button and the SPACE 
BAR to execute the corresponding command. 

 

9.2.1. Selecting the type of display 
Even if the default display type is configured by the programmer, the operator can 
modify it according to his needs.  
To modify the display type, click on the mouse right button and open the control 
menu. 
These are the displays available in the Alarms window: 
Large Icons: Displays the alarm texts under the corresponding icons indicating the 
priority. 
Small Icons: Displays the alarm texts under the corresponding icons indicating the 
priority in a size smaller than in the previous option. 
List: Displays the alarm texts in a list of icons indicating the priority. 
Details: Displays the alarm texts in a list of icons indicating the priority. There are 
also some columns (sizable by the operator) displaying data related to each alarms 
as follows: 
 

Description: Alarm Text 
ON: When the alarm occurred 
ACK: When the alarm acknowledge occurs. 
Priority: Type of priority of the alarm. 
State: Status of the alarm. (0=OFF / 1=ON) 
 

Note: By enabling the display type “detail” you can select the color for each priority 
type. When you enable the color, the font of the alarm text will be automatically 
decided by the system. 
 

9.2.2. The Alarm priority 
During the configuration of the alarms, the programmer should associate a priority 
level with each of them. This priority level should indicate the seriousness of the 
alarm. The operator can modify the color associated with the priority level by 
selecting the Color command button. Remember that this property sets the font 
without the possibility of modifying it.  

The alarms can be arranged in the alarm window by priority level by 
pressing the priority button, when the window is in the style properties with 
the "Details" list.  

 

9.2.3. Occurrence and acknowledge time 
If you select the “Details” display in the style property, the time when the alarm 
occurred and when it was acknowledged will appear in the corresponding column.  
Occurring Time, appears in the column under the ON button on the right of the 
description column and specifies when the alarm occurred in the plant.  
Acknowledge Time appears in the column under the ACK button on the right of the 
description column and specifies the time the alarm was acknowledged by the 
operator. 
The ON and ACK buttons on the upper border of the window allow you to put the 
alarm in chronological order. 
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9.2.4. Alarm Description 
The string text describing the alarms is necessary to identify them and, so, it is 
always displayed in the alarm window. 
The Description button on the superior border of the window (when the “Details” 
style is selected) allows you to put the alarm description in alphabetical order in the 
window. 
 

9.2.5. More information about an alarm 
Movicon allows you to associate a help string with each alarm to supply more 
information about the alarm.  
The help string is a string defined in the string resource and associated with the 
corresponding alarm by the programmer.  
In order to display the help string, the “?” button must be available. In fact, when 
the alarm is selected, to display this string you must press the "?".button: a pop-up 
window containing  the string will appear. 
To close this window, press ESC, or click with the mouse in the working area. 
The display occurs only if a single alarm is selected. 
 

9.2.6. Acknowledge Alarms  
When an alarm occurs, it must be recognized before a possible reset.  
• This operation will be reported in the alarm window, as well as in the Historical 

Log window with the acknowledge time. 
The operation can be one for all the active alarms and is performed by using the 
“Ack all” button, or by using the “Ack” button only to recognize the selected Alarms. 
From the alarms window it is possible to acknowledge each alarm individually, 
selecting it with the mouse or the UP/DOWN arrow keys (selecting the window con 
TAB if necessary. If acknowledge a number of alarms simultaneously, select the 
required alarms dragging the selection with the mouse, of with the keyboard, select 
the alarm window keeping the UpperCase key pressed and using the Up and Down 
arrows.  

Note: the acknowledge operation can be performed by a variable defined 
inside the project. The effect will be the same as that using the pushbutton. 

 

9.2.7. Reset Alarms 
The Reset of an alarm will make it disappear from the alarm windows, if the cause 
which generated it is not present any more. If the cause is still active, a Reset 
(according to ISA standards), will restore the alarm and you will need to 
acknowledge it again.  
The Reset of one or more alarms can be executed only if the acknowledge 
procedure was performed before. 
The Reset operation, if performed properly, will be recorded in the Historical Log 
with indication of the time the alarm disappeared under the OFF voice. 
The operation can be one for all the active alarms and it is performed by using the 
“Reset all” button, or by using the “Reset” button to reset only the selected Alarms. 
From the alarms window it is possible to acknowledge each alarm individually, 
selecting it with the mouse or the UP/DOWN arrow keys (selecting the window con 
TAB if necessary. If acknowledge a number of alarms simultaneously, select the 
required alarms dragging the selection with the mouse, of with the keyboard, select 
the alarm window keeping the UpperCase key pressed and using the Up and Down 
arrows.  
 
Note: the reset operation can be performed by a variable defined inside the project. 
The effect will be the same as that using the pushbutton. 
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9.2.8. Comment about an alarm 
If present on the left border of the window, the comment button allows you to type 
in edit window comments associated with the alarm.  
For example, the operator can communicate some information, suggestion or, … to 
other operators.  
The comment remains associated with the alarm until it is deleted from the 
corresponding comment window. 
 

 
 

Comment associated with an alarm 

 

9.2.9. Printing of the alarms 
The operator can print the alarms by using the corresponding commands from the 
file menu or from the mouse right button.  
 
 
 

9.3. The Messages window object 
Movicon message window, depending on the way it was configured in the project, 
allows the operator to perform a complete management of the plant messages. The 
window, whose size was defined in the project, allows you to visualize the messages 
related to the plant or to a restricted area of the plant. 
Each alarm can be associated with: a description, information about the time it 
appeared, comments, etc …). 
 

When the cause, which generated the message, has disappeared, the message 
disappears without requiring any acknowledge or reset operation.  

 
For each message, apart from the text, further information can be associated or 
comments can be entered. However, this information cannot be displayed in the 
window if it has not been set by the programmer. However, we shall proceed with 
the description, bearing in mind that availability for the operator depends on the 
project specifications. 
The use of the Comment or ? buttons, configuring the message window, selecting 
the message area … is already described earlier under the Alarms window. 
 

The operating mode for selecting Messages Area to be displayed or type of 
Message display are identical to the description in the previous paragraphs. 
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10. Historical Log 
The purpose of the Historical Log is to 
record in chronological order all the 
significant events and alarms that occur 
in the plant managed by the project. 

The purpose of the Historical Log is to record in chronological order all the 
significant events that occur in the plant managed by the project. 
These events are:  
 
� System operations carried out by the operator. 
� System diagnostics (auto-diagnosis, Driver diagnosis). 
� All project alarms and messages considered important by the programmer. 
� The contents of the plant variables associated with project strings upon 

event established by the programmer. 
� Messages from other applications, chosen by the programmer. 

 
Apart from the messages recorded by the system, all the other events can be 
recorded only if the programmer has allowed for the possibility in the alarm or 
message command settings in the General Logic program. 
The events will be recorded according to the settings made in Historical Log from 
the Movicon Settings menu during the programming phase. 
It is therefore up to the programmer to decide if and how to print the alarms, if and 
how to execute the backup of the historical data, the database file size and other 
parameters needed by the system for the Log management. 
The events recorded in the Log can be displayed, in clearly distinct ways, through 
two very different types of windows linked to different types of archives. We will 
define these as Default Historical Log and Optional Historical Log. 
The following paragraphs show the difference between the two types of Log 
management. 
 
 

10.1. Default Historical Log  
The Default Historical Log is always present in any project, and the corresponding 
recording engine is automatically activated at every project start. 

The engine records the Log events and messages, in the manner established 
in the settings, in specific ASCII files called LOGxxxxx.INI by default, where 
the x’s are replaced by progressive numbers. 

Each file constitutes a Log database which can be displayed by a special system 
window that can be activated solely in runtime by selecting Historical Log from the 
Windows menu (ALT+L).  
All the events described above will be listed in the "Message List" window and 
sorted in chronological order. 
The programmer can decide whether to display chronological details as year, 
month, day, time, hours, minutes or seconds or as combinations of these.  
To view the messages that do not fit in the window, use the scrollbar on the right of 
the window, the UP/DOWN arrow keys or the PAGE UP/DOWN keys.  
The CTRL+HOME and CTRL+END key combinations send the cursor to the beginning 
or end of the LOG text. 
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An example of a default historical log window 

 

10.1.1. Message list range 
The Message list range box tells the user the chronological range to which the 
messages in the list refer. 
The range usually shows a starting date and, if there is more than one range, also a 
final date. These dates correspond to those of the first and last message in the Log 
list. 
If you want to display a different message list range from the current one, you can 
scroll through all the ranges present using the box’s dropdown list and selecting the 
one you want from those available using the techniques described in the "Using a 
Dialog Box" chapter. 

Note: in practice every message list range corresponds to a Log file. If you 
select and display a different range, the system will continue to record the 
events in the active range in the background. 

The default historical Log window allows you to look for texts or dates using the 
Find command on the right of the message list field. 
 

10.1.2. The Find command 
It is sometimes useful to search for a key-word inside a list of messages in order to 
find the desired messages quickly. To do this, press the Find button, which will 
open a dialog window (see below) allowing you to type the desired search key word.  
 

 
 
You can select the search direction (up or down) by selecting the corresponding 
radio button or specify if the system must be case-sensitive. 
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10.1.3. The Backup 
The Backup control button allows to force a saving of present Log file. The saving, 
hereinafter named as backup, will be made automatically on destination disk with 
the path set by the programmer on default Historic Log Settings. If the 
programmer has not set any path or has enabled the choice possibility to operator, 
by pressing backup button the dialog box for destination file choice will appear.  
Unless otherwise specified, Movicon will use default name, path and unit. 
 

 
The cancellation of backup 'operation will involve the saving on Log file 
of system message “Backup procedure aborted by operator”.  
 

 
 

 
 

Box for manually setting the backup file 

 
By means of this dialog box, the operator can type the file name on which the 
backup will be performed by means of the “filename” editing box; alternatively, 
leave the default name which will automatically appear on box.    
You can select the path by choosing it from among the available paths on Directory 
summary box. Then select destination unit or disk by Windows standard techniques.  
Unless otherwise specified, Movicon will use default name, path and unit. 
The "Save" control button will start the saving. The "Cancel" control button will 
cancel the operation.  
 

The operation cancellation will involve the saving in Log file of system message 
“Backup procedure aborted by operator”.  
 

For further details on backup settings, please read the relevant chapter of the 
programming manual. 
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10.1.4. Font of the default Log window 
You can customize the Font used for the displaying of the texts in the default Log 
window. To modify the predefined Font, select the Font command from the File 
menu. This command is available when the Log window is active. 
By means of the standard Windows techniques, you can select the required font for 
the text in the Log window. 
 

 
 

Window for the Font configuration 

10.1.5. Printing the default Log 
The print can be performed each time a new event occurs or can be delayed. These 
settings are specified by the programmer during the building of the project. The 
operator may decide to print the default Log by selecting the Print or Print 
Preview command from the File menu. The Print command opens a dialog window 
for the settings of the printing, complying with the windows standards and the 
Printer type. 
If you want to print only a part of the contents of the Log, first select the desired 
text as described below: 
Using the mouse, click at the beginning of the selection and, keeping the mouse left 
button pressed, bring the mouse pointer to the end of the selection, then release 
the mouse button. To deselect a previously selected text using Select all or 
selected partially, click with the mouse in any position inside the window.  
To select the text with the keyboard, use the TAB and arrow keys to reach the 
beginning of the selection, then keep the upper case pressed and use the arrows 
until you reach the end of the selection. To deselect previously selected text, simply 
press any arrow key. 
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10.2. ODBC Historical Log  
As well as the Default Historical Log, Movicon provides an Optional Historical Log. 
This must be enabled and configured in Movicon Historical Log Settings. 
The Optional Historical Log records events like the Default Historical Log, but 
handles the archives in a very different manner. The record engines of this type of 
Log create database files of size defined during programming, in the format 
specified by the user. 

If enabled, the optional Historical Log records events in database files using 
the ODBC standard. The database files containing the log archive can have 
the format of the required database (Access, FoxPro, Paradox, dBase, 
Oracle, SQL, etc.). 

This feature, very popular among users who have company management programs, 
is made possible by the ODBC link, which allows Movicon to record in the set format 
according to the Open Database Connectivity standard. 
 

The ODBC link settings are performed by using Microsoft standards and 
may depend on the type of driver used for the database you want to 
connect to. Further descriptions of ODBC links are contained in the 
relevant chapter in this manual. 

 
Although the archives recorded by Movicon can be read by the company 
management program database application, they can also be displayed by using a 
special object window called the Log Window. 
 

Like other window objects, the Log window can be inserted and configured as 
you choose in any project synoptic. 

 

 
 

Example of screen page containing a Log object 
window and (smaller, bottom left) an Alarm object 

window. The Log object uses ODBC links and allows 
SQL queries. 

 
The next paragraph will describe the operations the operator can perform with the 
ODBC Historical Log window. 
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10.3. Operations you can perform in 
the ODBC Historical Log window 

The ODBC historical Log allows you to perform custom and advanced operations for 
the management of historical data.  
When you press the mouse right button close to the Log window, a pop-up menu 
appears, giving you the opportunity to customize the commands concerning the Log 
window. Some of them are directly available from the command buttons on the 
sides of the window. 
 

10.3.1. List Type 
This list box allows you to select the style used for displaying the message lists in 
the window. The possible list types are: 
Large Icons: choose this option to display only the texts arranged in the window 
under their respective icons indicating the type of event. 
Small icons: choose this option to display only the texts arranged in the window in 
columns of icons indicating the type of event, with smaller icons than the previous 
option. 
List: choose this option to display only the texts, arranged in the window in lists of 
icons indicating the type of event. 
Details: choose this option to display texts arranged in the window in lists of icons. 
The window will also show columns (sizeable) indicating the data for each single 
message as follows: 
 

� Event: Log message text 
� Date: Time message appears 
� Event Num: Event code number (e.g. priority) 
� Event Type: Type of message (Alarm ON, ACK, OFF, Message ON, OFF, 

system, driver). 
� SubEvent: Possible help text associated with alarm. 
� Extended: Comment that can be associated with Log by operator. 
� Comment: Comment that can be associated with Log by operator. 
� User: User active at the time of recording. 

 

10.3.2. Select Log messages 
The Log window allows you to display only a given type of message from among 
those present in the window (list field). The selection is made according to the 
settable event type characteristic. This is permitted for all messages of the following 
type: 
 

� Alarm ACK  
� Alarm ON  
� Alarm OFF  
� Messages ON  
� Messages OFF  
� Messages from Driver  
� System Messages 

 

10.3.3. Sort Log messages 
The Log window allows the messages in the window (list field) to be sorted 
according to various settable characteristics. The messages can be sorted by: 
 

� Event: Log message text 
� Date: Time message appears 
� Event Num: Event code number (e.g. priority) 
� Event Type: Type of message (Alarm ON, ACK, OFF, Message ON, OFF, 

system, driver). 
� SubEvent: Possible help text associated with alarm. 
� Extended: Comment that can be associated with Log by operator. 
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� Comment: Comment that can be associated with Log by operator. 
� User: User active at the time of recording. 

 
 

10.3.4. Refresh 
When you open the optional Log window, you must normally refresh the data before 
analyzing them. Click the Refresh button to read the data recorded in the database 
linked via ODBC. 
 

10.3.5. Query SQL 
The optional Log window allows you to set the standard SQL language command for 
making customized data analysis queries. For SQL command settings, refer to the 
specific SQL programming manual. 
 
Example 1: if you want to extract from a turbine management project’s Log 
archive only the alarms for turbine number 1, identified in the alarms as “Turbine 
1”, you must type the following string:  

SELECT *FROM Historic WHERE Event Like '% Turbine 1' 
 

Example 2: if you want to extract from a project’s Log archive only the ON alarms, 
ignoring all other events, you must type in the following string:  

SELECT * FROM Historic WHERE EventType = 'ALARM ON' 
 

Example 3: if you want to extract from a project’s Log archive only the alarms 
falling within a given time period between one data and another, you must type the 
following string:  

SELECT * FROM Historic WHERE Date >= '1998/04/24 10:00:00' AND 
Date <= '1998/04/24 18:00:00' 
 

Example 4: if you want to extract from a project’s Log archive only the alarms that 
occurred while the user Ross was active, you must type in the following string:  

SELECT * FROM Historic WHERE User = 'Rossi' 
 

10.3.6. Messages list field 
The box marked Message List Field indicates to the user the chronological period to 
which the messages contained in the list refer, as described for the default historical 
log. 
The field box usually indicates an initial date and if more fields are present also a 
final date. These dates will correspond to the one of the first and of the last 
message present in the Log window. 
If you want to display a field different from the actual one, select it in the combo-
box using the techniques described in the chapter “Use of a dialog window”. 
 

Note: in practice every message list corresponds to a Log file. If you 
select and display a different field, the system will continue to record the 
events in the background over the current range. 
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11. Trends 
Trends allow recording and display of 
plant variables. The Trend windows allow 
data analysis according to the operations 
envisaged by the programmer. 

Movicon’s Trends allow you to display or register graphically the evolution of 
specified variables representing the plant status. Trends are thus the most efficient 
tools to register, print and analyze graphically the behavior of some variable 
(mostly analog) representing the plant, such as temperature, pressure, levels, 
weights, chemical measurements or any other physical value converted in an 
electrical signal.  
Movicon allows you to represent variables on graphic curves through different 
techniques discussed in the following chapters: 

 
The  Trends boxes can be fully configured by  programmer. Consequently, 
the graphic aspect and working options, such as buttons, variables, pens, 
display, texts and other details will vary from one application to another 
one.  

 
 

Vectorial Trends 
This type of Trend is based on Movicon’s Vectorial Graphics and it allows an 
advanced management of data and of registration engines, and it also allows 
graphic representation of the values registered in the Data Logger.  
 

 
 

Example of Template containing a symbol made up by 
a Vectorial Trend object and by other correlated 

objects. 
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Dynamic Trends 
Movicon proposes two objects which are able to display the evolution of the 
variables without any registration. These objects also allow you to visualize in XY 
mode, drawing the curve based on the X and Y co-ordinates. For more information 
about these objects, see “Instrumental Trend and XY Plot” in the “Object” chapter in 
this manual. 
 

 
 

Example of XY Plot. This graphic, unlike the 
instrumental trend, represents data with both X and Y 

co-ordinates associated with variables.  

  
 
 

11.1. Vectorial Trends 
Vectorial Trends are the most powerful tool to manage display, analysis and 
registration of data contained in Movicon’s variables or database files. 
The Vectorial Trend object is a tool which allows you to visualize and register data 
but it also links to the database objects inserted in the Data Logger, thereby 
allowing representation of time and event based historic data. 
 

As it is based on a vectorial design, the Vectorial Trend supports all the 
animation and configuration characteristics typical of a graphical symbol. 
The vectorial trend is a powerful tool for visualization and registration; it 
can register data in .CSV standard format and can visualize those data as 
well as the data registered by the Data Logger. 
 

The vectorial trend is designed to guarantee maximum flexibility in the 
management of graphic display of recorded data. This means there is amply scope 
for using this object, not only for graphic representation of data but more 
appropriately for working. 
The Vectorial Trend is able to display the data registered by the Data Logger. In 
this case the Data Logger performs the function of registration engine. 
Nevertheless, the Trend is also able to register associated variables data in CSV text 
format and recover the recorded values by means of the data import function. If the 
vectorial trend is maintained inside an active synoptic, by activating the "Do not 
destroy window in RUN" option, it becomes a constantly active recording engine.   
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11.1.1. Vectorial Trends functionality 
The Vectorial Trend has three functions: 
 
1. display of real-time variable curves. 
2. display of data registered in the Data Logger curves. 
3. output Recorder of sampled data. 
 
The main task of Vectorial Trend does not consist in registering data archives. This 
is a Data Logger task (Data Logger is described at previous chapter). The main task 
of Vectorial Trend is data representation by means of a set of graphic functions 
which can make these data as clear as possible to the operator, based on functions 
which can be widely customized.   
Recording is not the main task of Vectorial Trend object. The recording for data 
graphic analysis is a task of Data Logger, as previously said.  
However, the Vectorial Trend can record data in order to make available data 
sampled by file output object, which can be read on Ms. Excel or any other non 
database applications. In fact, files saved data use  .CSV format, or text format 
with separator, interpreted by Excel and many other applications. 
 

 
Block diagram of Vectorial Trend function 

Recording text on file is optional and must be enabled in the Trend object 
configuration properties. This type of recoding is not suitable for large quantity of 
data or if filters are to be applied. These operations can be easily implemented if 
historic data recording is done by the Data Logger. 
 
Just remember that when Trend object is enabled to send sampled data in output 
on file, this will take place only if the object is active on memory, i.e. if the synoptic 
containing it is displayed or has not been “discharged and destroyed” with page 
change. 
 

Registration on .CSV file is performed by the Trend object only if the last 
one is in memory. To keep the Trend object active in memory make sure 
that the synoptic it is contained by has not been destroyed and unloaded 
from memory with the change of page. To avoid this, check the “No 
destroy window in Run” option in the synoptic window general 
properties. 
 

The registration on file is wholly independent and asynchronous from registration 
with the Data Logger. The actual writing of data on file will be performed through 
the cache memory, so as to gain access to disk only when requested by the type of 
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sampling. Other functions allow to define the number of files and their maximum 
size. 
The values registered on file will use the following format if the file is open with 
Excel: 
 

 
 
 
Date and time values are recorded following the settings fixed in the operating 
system under the International Settings voice in the Control Panel. 
The separator character can be chosen during the Trend configuration. The 
available separators are Tabulation and Comma. 
 

Trend Operativity  
The Trend has two possible statuses: Start and Stop. Those are specified by a 
variable, which is assigned through the Variable property of the Trend. 
When the Trend is in Start status, it samples and display data as set in the 
Execution property of the Trend. The buffer memory managed by the Trend can 
be configured as desired with a maximum capacity of 10,000 samples. 
When the Trend is in Stop status, you can display the contents of the buffer. If a 
Data Logger engine is associated with the Trend, the contents of the buffer could 
be data extracted from the corresponding database; otherwise the contents of the 
buffer will be the samples registered by the Trend during the start status. 
Remember that even during Stop status the Trend object keep on sampling, 
buffering and registering data. 
The values in the buffer can be displayed using the corresponding scrolling 
command set in the Trend properties and can be associated with Movicon’s 
variables. The cursor will point to data as requested by the configuration performed, 
as we will discuss in detail in the chapter about Trend properties. 
  

11.1.2. Link between Vectorial Trend and Data Logger  
The Vectorial Trend is designed to be linked with a registration engine managed by 
the Data Logger resource. 
In this case, you can manage the Trend object in Start mode as display of data 
defined by the settings, and in Stop mode as display of the data extracted from the 
database registered in the Data Logger following extraction criteria defined by a 
query. 
The Trend will represent graphically the extracted values from the database file, 
which will be loaded in the buffer of the Trend when the Trend switches in Stop 
mode. 
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12. Passwords and User 
A Movicon project can manage the 
security of access according to 
management of users,  passwords and 
access levels. The users can be 
addressees of SMS, Faxes, Voice 
Messages, Email messages. 

Where appropriate, Movicon supervision system can enable Password management 
to increase security and diagnostics of processes requiring it due to company needs 
or due to a high risk or complexity of above process. 
In a project Users and Groups of Users can be defined. They are necessary for an 
eventual sending of messages by event or alarm. This is for handling security to 
project functionality access. In fact, every control, which can be set from Movicon in 
project, can be associated to a prompt of one password, in relation to user level or 
to a specific user. In addition to this, Movicon system controls require (provided 
that password management is enabled) an access level equal to or higher than level 
4. 
Movicon password management is complete and efficient. In fact, it is structured by 
Users.  The plant manager assigns a string of characters as a password and a Usage 
level to each of them.  
 
The main definitions in the password management are:  
 

• Password: This means a string of a maximum of 32 characters (case 
sensitive) which represents the access key which, combined with the user 
name, allows the user to execute a command characterized by a certain 
user level defined by the programmer. Each character typed will be 
replaced with an asterisk on the screen, in order to prevent other 
operators from seeing it.  

• User: A string name containing a maximum of 32 characters (case 
sensitive) making it possible to identify an operator or a user of the plant 
or of the process. Each user in the user list must have a password and a 
user level. 

• User level: The access level that a user has when he is using Movicon. 
Movicon proposes 8 normal user levels, apart from the ninth and tenth 
which are meant for the System Engineer and the Programmer. 

 
"User Level 1" is the lowest level; this means that operators with this level have the 
lowest operativity in Movicon. 
The configuration and activation of password management can be performed only 
by the programmer using the corresponding setting window. 

 
If you are planning to activate password management for a project, you 
need to define at least one user with the user level: “development”, for 
the programmer of the project. 

 
To install new users, select the user Access Passwords command from the 
Settings menu. This operation can only be performed by a user having the 
"System" or "Development” level, to prevent unauthorized access.  
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12.1. Inserting a Password and 
activating an User 

If the operator selects a command with which the programmer has associated a 
password, the system will open a dialog box asking him to type its user name and 
password. 

• The lower border of the window will display the user level or the specific 
user name required. 

So, each command can be protected with a password, as defined by the 
programmer. 
The password may require: 
 

1) A user level: you need to type the user’s own name, followed by the 
password. Each user has a specific user level. 

2) A specific User: you need to type the required user name with the 
specific password. In this case, only the user name and the password are 
relevant, but not the user level. 

 
When you type the password, the characters are replaced by asterisks to prevent 
other operators from reading it.  
If you want to cancel the operation, press the "Cancel" button or press the ESC key. 
To confirm the data inserted, press the ENTER key or the "OK" button. 
 

 
 
 
When the user name and the password are accepted by the system, the operating 
command will be executed. 

• At the same time, Movicon will consider the user inserted as active, 
recording the user name with the date and time of activation in the 
historical log. 

 
Every operation or command associated with passwords having a user 
level equal or smaller than the one active will no more require a 
password; The system considers by default that the user is always the 
same if the AutoLog Off. function is not enabled. If this function is 
enabled by the programmer, the user will be automatically deactivated 
after the time set. 

 
Every operation or command associated with Activation or 
Deactivation of a user will be recorded as "System Event" in the 
Historic Log. If password management is not enabled, and Movicon is 
used as WinNT/2000 service, Movicon will consider the User as an active 
user (LogOn) at that moment.  
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12.1.1. Deactivating a user 
After enabling a user, it can be disabled at any time (for instance due to shift 
change). To do so, enable the Settings item of main menu and select the User’s 
Disabling control or type CTRL+D. 
This operation will ensure that no users are active. Consequently, the next 
operating command for which a password is associated will again request a user’s 
ID based on what is described above. 
The deactivation command will be automatically recorded in the historical Log 
indicating the date and time. 

• A user deactivation command can be predefined by the programmer and 
associated with a resource or Movicon symbol. 

• If preset by the programmer, the deactivation or auto Log-off can occur 
automatically after the specified delay.  

 

12.1.2. Installing a new user 
A new user can be installed in addition to the ones already present in the Movicon 
user’s list.  
A new user can be installed from the Settings menu or with a suitable command 
provided by the programmer to manage access to the system functions according to 
the application criteria. If the Movicon Settings menu is not available, check the 
command provided by the programmer for installing new users in runtime. 
Unless otherwise specified, to install a new user, activate Settings from the main 
menu and select the Edit User command. The window displayed is as shown below. 
 
 
 

 
 
 
To insert a new User in the user list, type the user name and the password in the 
corresponding edit box, select the user level and then press the Add button. A 
new dialog box will appear, asking to confirm the password. If the confirmation 
corresponds to the previously inserted password, the user will be added in the user 
list. To delete a user, first select it and then press the Delete button. 
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12.1.3. Notes on CFR21 Standards Part 11 
Movicon 9.1 completely supports the standards of Electronic Signature with 
reference to FDA specification CFR 21 Part 11. 
The application projects to be validated in accordance with the standards must  
apply password management correctly; furthermore, they must also use specific 
operating system functions such as WinNT/2000 to guarantee safety in accessing 
historic data recorded by Movicon and prevent these being tampered with. Movicon 
must be used as a Service of the operating system. 

 
It is the programmer's responsibility to ensure correct 
application of the procedure in accordance with the standards. 
 
 

Movicon offers the following functions: 
 

1. Univocal management of password user names 
2. Access by univocal combination of UserID and Password 
3. Recording historic data of printable names, univocal, associated with 

password user  
4. Recording every attempt of unauthorized access in the Log  
5. Procedures for discouraging intrusion into the system  
6. Automatic Auto Log Off procedure 
7. Automatic functions for recording historic data with ID of active password 

user. 
 
Further information for correct application of the standards is given in a special 
document provided by Progea. 
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13. D.D.E. Link  
The DDE is a tool which makes it 
possible to connect Movicon with other 
Windows applications. 

Movicon fully supports the communication standard with other Windows applications 
called DDE (Dynamic Data Exchange). This standard, created by Microsoft, allows 
different applications to communicate and exchange data via a software 
communication protocol. 
Windows applications that support DDE can therefore dialog with Movicon and 
exchange information dynamically either in Client or in Server mode.   
Movicon also supports NetDDE, i.e. the capability for exchanging DDE data between 
applications on different PCs using a Windows-supported network. 
The DDE protocol is supported by almost all Windows applications. This feature 
permits interfacing between factory supervision and any other application, from 
small custom-built applications in Visual Basic to company administration 
management. 
However, DDE is now technically rather outdated. Microsoft has developed 
application interface technologies in OLE (Object Linking and Embedded) 
technology, leading to the current COM (Component Object Model) technology from 
ActiveX. Refer to the relevant chapter in this manual for information on these new 
technologies supported by Movicon. 
 
 

 
The DDE function is considered as optional. It must therefore be enabled 
by the license purchased. To check if the option is enabled execute the 
“Check Dongle Options” command from the File menu. 
 

 
 

 
 
 

13.1.1. Movicon in Server mode 
Movicon is a native DDE Server application. You need do nothing in your project 
when another application requests information from Movicon, i.e. when another 
application reads data from Movicon variables. In this case the Client (the other 
application) requests the variables in the Movicon memory areas according to its 
addressing procedures, while Movicon (the server) undertakes to meet the requests 
for information. 
In this case Movicon has to do nothing at all: it is the Client that has control over 
communication.  
The examples given on the Movicon CD refer to the use of Movicon as Server and 
Excel™ as Client DDE. Excel is one of the most widely-used Microsoft products. 
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13.1.2. Movicon in Client mode 
Movicon can take the necessary action to establish connection and request 
information from other applications. In this case Movicon is the Client while the 
other application that provides the required information is the Server. 
This mode does not (normally) request action on the server, while Movicon requires 
configuration and definition of the data requested. Thus Movicon must know the 
identity of the other application, the service required and the Item. 
 

13.1.3. DDE Server Services offered by Movicon (Topics) 
The "software" communication protocol defined by the DDE (Dynamic Data 
Exchange) standard consists of a series of basic information that Client applications 
must supply to Movicon: 

� Service 

The Service is the name of the DDE Server application with which it is registered in 
Windows. Movicon is registered with the string "MOVICON". 

� Topic 

The Topic is a string sent to the application and determines the type of DDE 
command required. It must be recognized by the server as belonging to its DDE 
services list. 

� SubTopic 

The SubTopic is another string sent to the application to complete the command 
indicated, so it is generally used by the server application to add information to the 
command. 
 
For a complete list of the DDE commands and services offered by Movicon, 
consult the programming manual. 
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13.1.4. Examples of DDE between Movicon Server and 
EXCEL™ Client 
The Movicon installation disks contain some example files in Excel format 
(Movdde.XLS) and a Movicon project (Excel.prj) to demonstrate communication 
between a Movicon DDE Server and a DDE Client application. 
The Movicon project uses sliders to set some variables whose values are displayed 
in the Excel file in graphic form. 
 

13.1.5. Client DDE 
Movicon uses the DDE in Client mode when it is given the task of requesting the 
data areas of other applications and temporarily storing the contents in its 
variables. In this case the Server (the other application) provides its memory areas 
according to the services allowed by each individual application. 

 
For this purpose it is essential to know what services the other 
application has and to set the characteristics to be associated with the 
Movicon variables in the Movicon memory areas. 

 
The services for the DDE link with Movicon in Client mode can be set in the DDE tab 
under the Settings menu, as described in the Programming Manual. 
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13.1.6. Windows NetDDE 

 The DDE software protocol does not support common networks and is therefore 
only applicable among applications running on the same computer. The Windows 
NetDDE service compensates for this by handling the network communication 
between applications wishing to communicate in DDE. 
In order to ensure the Movicon DDE server is accessible to the Windows network, it 
is necessary to configure 
the utility DDESHARE.EXE 
on the computer in which 
the Movicon project is 
running. 
From the "Start" menu of 
Windows select "Run" 
and key in the name of 
the program 
"DDESHARE.EXE". The 
Windows NetDDE service 
is thus activated and a 
window is proposed for its 
configuration. 
A new DDE sharing must be created by selecting "DDE Sharing" from the 
"Sharing" menu. In the dialog window that opens select "Add sharing" and 
configure the window as described in the Programming Manual. 
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14. OPC (OLE for Process 
Control) 
OPC is an increasingly common standard 
that simplifies communication based on 
different bus technologies.   

OPC is the short for “OLE for Process Control”, where OLE refers to Windows term: 
“Object Linking and Embedding”, a powerful automation interface for Windows 
applications. 
OPC contains the concept of programs implementing a unified interface between 
different bus technologies on one side and programs for displaying and automation 
on the other. Thanks to standard technology, today communication between 
automation devices aims at satisfying the independence of individual 
manufacturers, to produce equipment compliant with OPC standard. Thanks to the 
unified interface, hardware manufacturers increasingly guarantee the availability of 
OPC interfaces, i.e. of OPC Server software products to complete their hardware 
products. The user is thus sure of being able to interface purchased products with 
any software application compliant with OPC standards.  
The OPC standard is defined by public specifications released by the OPC 
Foundation, with the support of all main manufacturers of automation industry, 
besides Microsoft.  
 
 
Movicon is an application based on OPC standard (both Client and Server). 
As a Client it is possible to interface with all OPC Servers based on 1.0A and 2.0 
standards; as a Server it allows to share all or part of project variables with other 
applications and to notify to them events like alarms, messages, system 
information, and variations in project internal variables.  
 
Considering the increasing use of the OPC standard in industrial automation, it is 
crucial to consider this technology as a communication mode with devices on bus 
networks or simply other local or remote applications.  
 
 
 
 
 
 

 
Figure shows the block-diagram of a typical OPC 

communication  
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14.1. OPC Client Editor 
In OPC communication, Movicon uses a Client interface which can be fully 
configured and supports OPC 1.0A and 2.0 specifications. This resource, integrated 
in the system, is named as the OPC Editor name and can be accessed from the 
Movicon Resource menu, or by F7 quick command. 
 
 

 
 

Figure shows OPC Editor resource of a Movicon 
project 

This resource allows to set the OPC communication with one or more servers. 
Movicon displays a list of available servers on local PC, but it can also use OPC 
servers installed on remote or network connected or web connected PCs.  
Presently, two OPC server interfaces are supported: “DataAccess” and 
“Alarms&Events”, which are identified with  “DA” and “AE” initials, respectively. 
 
Data Access Specification 
The first type of server is organized in a structure composed by groups and items, 
as shown in the figure. It allows to connect I/O or internal variables of a device, 
which is part of a field bus network with Movicon project variables.   
 
 

Item 1

Group

Item 2

Item 3
 

Figure shows the relationship between group and item 
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Alarms & Events Specification  
The second type of OPC servers, “Alarm&Event”, notifies the appearance of specific 
event and alarm specifications configured within the very server; then, the 
appearance of a specific event or alarm can be recognized within a Movicon project, 
thanks to the notification by the OPC server and then can be managed, 
consequently.  
 

The management of events and alarms sent by OPC server AE is possible 
by using the relevant event of any basic script within the project. Please 
refer to the basic script manual for further details on this topic.  
 

 
 
 

14.2. OPC Server 
In addition to OPC Client interface, whose configurability of connections to OPC 
Servers has been described in the previous paragraph, Movicon integrates OPC 
Server function, that is it makes available and notifies events to any connected OPC 
Client applications. The Movicon OPC server supports the Clients implemented 
based on OPC “DataAccess” and “Alarms&Events” standards. 
This technology allows sharing of project variables with other applications complete 
with OPC Client DA and in the meanwhile it can notify to a Client AE events such as 
Alarms, Messages, system Information and variations in real-time database 
variables of application project. 
 
Any OPC Client to be connected to Movicon OPC server, based on the project 
parameter settings, can avail of a list of items to which one can connect. The list is 
contained in a group identified by the project name and every item takes the same 
name of the project variable to which it is connected. The possibility to change 
value is controlled within the project on settings of every single variable. This allows 
to make Movicon variables visible outside with maximum security.  
On the basis of the project settings, the Movicon OPC  Server can be automatically 
started at the time when a Client attempts to get connected and in the meanwhile 
its execution can be automatically stopped when shutting down connection with the 
Client. 
 
 
 

 
 

Figure shows the selection of items by a mutual OPC  
Client 
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15. O.D.B.C. 
Movicon fully supports the Open Database 
Connectivity standard which allows data 
storage in a standard format and a real-time 
connection with external databases.  

Open Data Base Connectivity (ODBC) is the Microsoft standard that allows an 
application to organize data in database files in the specific format of any other 
application capable of supporting this standard.  
By using this technique it is possible to overcome data exchange barriers between 
different formats. 

For example, using ODBC allows you to record the Log or record data 
tables containing Movicon variables. By using the ODBC link the data can 
be archived in the format required by the user. If for example the user has 
a management system based on MsAccess™, he can read and handle the 
data recorded by Movicon according to his needs. 

 

 
How data are linked according to the ODBC standard  

Movicon records data using the standard ODBC language. The ODBC link interprets 
the recordings according to how it is configured. The ODBC driver then records the 
data in the established format. The file or files will therefore contain the Movicon 
data but will be materially recorded in the format requested by the ODBC system. 
 

Movicon is independent from the format used to represent data, as 
the role of writing data belongs to the database owner or to the 
ODBC manager of the operating system. ODBC is a Microsoft 
standard, and the ODBC drivers are property of the owners of each 
individual application. 

For more information, refer to the ODBC on-line help or to the existing 
bibliography provided by Microsoft Inc. or by the owner of the database you 
are using. 
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15.1. ODBC Drivers  
To allow Movicon to log historical data on standard OBDC format files, Windows OS 
has to be complete with proper OBDC drivers for the chosen database product.  
During the typical installation Movicon will install necessary files for ODBC 
management and drivers for MsAccess™ and Excel™. You can use SQL Server as 
data format to install the relevant driver from Movicon CD ROM, by performing the 
“Tailor-made installation”.  

 
Movicon is preset to install ODBC drivers of Microsoft Access, Excel 
products and, with tailor-made installation, also the SQL Server MSDE. 
For all other database products, verify that the concerned driver OBDC 
supplied by the manufacturer has been installed.  
 

However, the operating system is complete with a set of already available OBDC 
drivers for different formats  (Paradox, FoxPro, dBase, etc.), accessible like all other 
ODBC settings from Control Panel at item ODBC Data Source (32 bits). 
 

15.2. ODBC link   
To allow an application to record data by means of the ODBC standard, apart from 
providing an ODBC  driver of the selected data format, it is also necessary to make 
the Connection between the server application and the destination file in which the 
values will be actually written by the ODBC driver. 
It is by means of the "connection" between the ODBC driver that a Movicon project 
resource can record data on file. All ODBC links must be registered in the Operating 
system by ODBC system settings from the Control Panel under the item ODBC 
Data Sources.  
Nevertheless, Movicon proposes a guide (Self Configurer) to create the ODBC link 
for all the Movicon resources or functions which allow its use. 
The ODBC link is a tool which connects an application to the ODBC driver allowing 
the application to write or read data in a standard format external to the 

application. The ODBC Standard is based on specifications defined 
by Microsoft.  
 

 
 
 

The window illustrates a list of the ODBC drivers 
installed by default by the Windows operating system. 

Other drivers could be present if other ODBC compliant 
applications have been installed. 
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When the settings of a Movicon object or resource allow it, the buttons for creating 
links, files or tables required for ODBC will be made accessible from the 
configuration window. 
 

 
 

Button for automatic or semiautomatic creation of 
ODBC links 

 
 

Button or icon for direct access to ODBC system 

 
The ODBC link can be configured by setting the data manually, launching the ODBC 
system from Movicon or from the Windows control panel, and clicking the icon 
shown above. To facilitate the configuration operations, Movicon has a Wizard for 
automatic or semiautomatic creation of files or links. 
Automatic creation allows you to create the link (and if necessary the file and/or 
table) in Access™ format with a single command. 

 
If the user uses the SQL Server™, Access™ or Excel™ database format, 
Movicon considerably simplifies management of ODBC links by performing 
the necessary operations with a single command. 

 
 

15.2.1. Connections Pool  

Starting with the 3.5 version of ODBC manager the "Connections Pool" tab was 
added for enabling pool 
management for each ODBC 
driver. 
"[…] The pool allows the user 
applications to use one of the 
connections available in the 
pool, so it need not be reset 
each time. As soon as a link is 
created, it is placed in a pool 
and the application can reuse 
the connection without having 
to repeat the entire 
connection procedure, with 
consequent improvement of 
performance." 
 
 
 

 
Always check to 
ensure that the ODBC driver supports pool management, before 
enabling it. 
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15.3. Creating ODBC links 
You must create ODBC links when inserting objects or resources into the project 
that generate data tables or databases to be recorded according to this standard. 
The ODBC link can be created automatically or semi-automatically by clicking the 
following button available from the settings or configuration window of the Movicon 
resource concerned: 
 

 
 
Click this button to open a Wizard which considerably simplifies creation of the 
document. 
If you want to use the MsAccess™ format, the Wizard can even create the link, file 
and table automatically. The Wizard has the following dialog box: 
 

 
 
 
If you leave the default settings, the link and the file with the corresponding table 
will be created automatically in the data format of Microsoft Access™, SQL Server™ 
ed Excel™. 
However, you can use the options available in this dialog box to create a 
customized link. 
Create File (MsAccess© Format): if this box is checked, the file will be created 
automatically with the syntax required for the link in Access™ 97, Access™ 2000 or 
Excel format. 
If this box is not checked, only the link (and possibly the table) will be created 
without creating the file. 
• The option of not creating a DB file is available for example when the file already 

exists and you do not want to replace it. 
• To use SQL Server, consult the next paragraph.   
Create Table: if this box is checked, the data table to be inserted in the DB file will 
be created automatically (the table is independent of the file format). 
If this box is not checked, only the link (and possibly the file) will be created 
without creating the table. 
• The option of not creating a data table is available for example when the table 

already exists and you do not want to replace it. 
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Create Index: if this box is checked, set the ID column and Time column as Table 
indices. Wherever possible, it is advisable to avoid eliminating this selection since 
using indices in the table ensures faster access to data. 

 
Note: On using the Microsoft Excel driver, indices must not be created in 

the table. 
 

 
Create Link: The link is essential for recording data. The link can be made 
automatically by using the Microsoft Access™ driver. If you want to use a different 
format for recording data, then you must set the link manually. 

If you select automatic link you only have to confirm the operation and 
wait for Movicon to make the data settings necessary for the ODBC to 
make the link using the MsAccess driver. 
 
Note: If you create a link without creating a table or a file, you must in 
any case make sure that they actually exist. If not, the system will be 
unable to record the data and will give an error message. 

 
 

15.3.1. Manual ODBC link 
You must create ODBC links when inserting objects or resources into the project 
that generate data tables or databases to be recorded according to this standard. 
The ODBC link can be created automatically or semi-automatically by clicking the 
following button available from the settings or configuration window of the Movicon 
resource concerned: 
 
 

 
 
 
Click this button to open a Wizard which considerably simplifies creation of the 
document. 
If you want to use the MsAccess™ format, the Wizard can even create the link, file 
and table automatically. The Wizard has the following dialog box: 
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If you leave the default settings, the link and the file with the corresponding table 
will be created automatically in the data format of Microsoft Access™, SQL Server™ 
ed Excel™. 
However, you can use the options available in this dialog box to create a 
customized link. 
 
Create File (MsAccess© Format): if this box is checked, the file will be created 
automatically with the syntax required for the link in Access™ 97, Access™ 2000 or 
Excel format. 
If this box is not checked, only the link (and possibly the table) will be created 
without creating the file. 

• The option of not creating a DB file is available for example when the file 
already exists and you do not want to replace it. 

• To use SQL Server, consult the next paragraph. 
Create Table: if this box is checked, the data table to be inserted in the DB file will 
be created automatically (the table is independent of the file format). 
If this box is not checked, only the link (and possibly the file) will be created 
without creating the table. 

• The option of not creating a data table is available for example when the 
table already exists and you do not want to replace it. 

Create Index: if this box is checked, set the ID column and Time column as Table 
indices. Wherever possible, it is advisable to avoid eliminating this selection since 
using indices in the table ensures faster access to data. 

 
 Note: On using the Microsoft Excel driver, indices must not be created in 
the table. 
 

 
Create Link: The link is essential for recording data. The link can be made 
automatically by using the Microsoft Access™, SQL Server or Excel driver. If you 
want to use a different format for recording data, then you must set the link 
manually. 

• If you select automatic link you only have to confirm the operation and 
wait for Movicon to make the data settings necessary for the ODBC to 
make the link using the MsAccess driver. 

 
Note: If you create a link without creating a table or a file, you must in 
any case make sure that they actually exist. If not, the system will be 
unable to record the data and will give an error message. 
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15.4. SQL Server with MSDE  
To use the SQL Server data format, Movicon allows installation of Microsoft MSDE, 
the standard SQL Server engine. To use the actual SQL Server product available, 
the user will abide by the instructions in the SQL Server User Manual. 
The Microsoft MSDE service is installed automatically from the Movicon installation 
CD-ROM. 
The Microsoft MSDE manager provides for use of .MDF formats of SQL Server freely 
managing customized tables within a single “Master.mdf” file.  
If MSDE is to be reinstalled, launch the “MSDEx86.exe” file from the directory in the 
Movicon CD-ROM, following the installation instructions in the "readme.txt" file. If 
errors are encountered during the installation, refer to the “Setup.log” file, and 
more specifically, the “Sqlstp.log” file in the Windows installation directory. 
 
Before making any ODBC connection with SQL Server data format, follow the 
Microsoft MSDE procedure given below: 
 

1. Launch the MSDE Service Manager program 
 

 
 
 

2. Start/Continue the MSDE engine 
 

 
 

3. Ensure that the icon appears in the Windows menu 
 

 

 
 

 
4. Using the Data Logger, carefully create the database structure as follows: 

a. Insert as user name “sa” (system administrator) for unlimited 
access (or use one of the SQL Server editors available on the 
market). 

b. Do not enter the password. 
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5. Proceed with creation selecting “Check ODBC Link”, “Automatic SQL 
Server” and "Create Table" from the Movicon "Edit" menu. 

 
6. If the ODBC link already exists with that name, overwrite it (the 

corresponding columns and tables must not be modified). 
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16. Printing 
documentation 
The project may require 
management of printing of data, 
alarms or production reports. 
 
 
Movicon documentation or logic programs (whether general logic or LRP points) can 
be printed at any time using the Print or Print Preview commands from the File 
menu or by clicking with the mouse on the relevant button on the main toolbar. 
Movicon allows the project to be fully documented. In fact, all the resources, 
including their structure and associated commands, can be documented. 
All the Logics and variable Cross reference Lists can also be documented. 

 
The document that will be printed is always the document or resource that 
is active at that moment, so you must activate the document before giving 
the print command. 

 
For example, to print the general logic program you must first select the General 
Logic resource, and to print the Variables DB you must first select it. 
To print the program contained in the LRP logic points of a synoptic, you must first 
select the required synoptic, display the LRP points (LRP from View menu or F4 
key) and select any one of them. The printout will show the contents of each LRP in 
numerical order specifying the number of the LRP point and its coordinates. To print 
another synoptic LRP program, select the new synoptic and proceed as described 
above. 
 

Before starting to print you must correctly set up the connected printer 
and the print options, which also depend on the type of printer 
connected. The list of printers available to Movicon depends on the 
drivers of the printers installed in Windows Setup. If the connected 
printer does not appear on the list, it must be installed following the 
procedures described in the Windows Installation Manual. 
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16.1. Print Setup 
The Printer Settings command from the Movicon File menu allows you to change 
the default printer and modify the print options. 
The same options are available by clicking the Properties button in the Print dialog 
box. 
Selecting this command opens a dialog box for the print setup and printer selection. 

 
Note: the printer settings vary according to the printer used. Refer to the 
printer’s manual for further information. The information below must be 
considered a general guideline only as the printer settings depend on the 
type of printer used. 
 

 
 

 
 
 
 
The group of settings marked as Printer allows you to select which printer, from 
those installed on the hardware platform, the print document will be sent to. 
If you want to change printer, scroll through the list of printers installed in the 
system and select the one you want. 
The Orientation option allows you to set the paper in Portrait or Landscape mode. 
The  Paper option allows you to size the print according to the real size of the paper 
and to select the sheet feed tray, if necessary. 
 

For further information refer to the Windows user’s manual or the printer 
setup manual. 
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16.2. Setting print font 
If you want, you can set a different 
font for the printer from the one 
selected for viewing on the screen. To 
set the print font, select the Printer 
font command from the File menu on 
the menu bar. A dialog box opens 
allowing you to select the new font 
from those installed in Windows. 
 
 
 
 
 
 
 
 

16.3. Page Setup 
When printing a document you can customize the pages by inserting headers and 
footers. The Page Setup command from the File menu allows you to insert 
headers or footers in the document you want to print. 
 
The codes displayed by Movicon by 
default determine: 
Header:  %H, %M correspond to the 

current time (file time or system 
time) 
%A, %d, %B, %Y correspond to the 
current date (file date or system 
date). 
&f corresponds to the name of the 
project file. 

Footer: &p corresponds to the current 
page number in the document.  

If you want, you can modify the codes 
as you choose in the edit boxes. 
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16.4. Layout Setup 
The Layout Setup command from 
the File menu opens a window 
allowing you to configure the paper 
and margins for printing the 
document. 
 
The available settings vary 
according to the type of printer 
used. 
 
 
 
 
 
 
 
 
 
 
 
 
 

16.5. Print Preview 
The Print Preview command from the File menu allows you to view the actual 
layout of the page or pages as they will be printed. This allows you to change the 
layout of the document if necessary before printing it. 
In the Print Preview window the mouse pointer changes shape when it is on the 
page to indicate that the Zoom function is active. Clicking with the left mouse 
button enlarges the page by a given amount and finally returns to its original size 
From the keyboard you can select the buttons called Zoom In and Zoom Out for the 
same function. 
You can start printing directly from the Print Preview window.  
 

 
 
To cancel the operation and return to the Movicon workspace, close the Print 
Preview window in the normal way or by clicking the Close button on the window’s 
button bar. 
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16.6. Printing the document 
Before printing the document, check that the printer is set up correctly, that the 
paper is correctly positioned and that the print settings are correct. 
Selecting the Print command from the File menu or clicking the Print button on the 
toolbar or from the Print Preview window will open the following dialog box: 
 

 
 
This window allows you to change the default options. The print range radio buttons 
allow you to print: 
 

• the entire document 
• the current selection only 
• a range of pages which you must specify in the edit boxes 

 
You can also specify the print quality, the number of copies to be printed and 
Collate. 
Click the Properties button to open a dialog box for the printer settings as described 
in the previous paragraph. 
For further information on print options, refer to the Windows user’s manual or your 
printer’s installation manual. 
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Movicon is a S.C.A.D.A. Software for Windows entirely developed and produced by Progea. 
© 2002 All Rights Reserved 
No part of this document or of the program may be reproduced or transmitted in 
any form without the express written permission of Progea Srl. 
Information in this document is subject to change without notice and is not binding 
in any way for the company producing it. 
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